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Introduction 
 

This updater has numerous convenient functionalities and improvements newly 

implemented. It works with all existing VOCALOID V1.0 library packages.  

 

Key features: 

-   New Synthesis Engine 

- More natural, intelligible and expressive. 

- Selection of overall "singing style". 

- Less tweaking time to get "more realistic" singing. 

 

-   Powerful and handy "Play With Synthesis" mode 

- "Play With Synthesis" mode enables you to play back the 

synthesis instantly. 

- Toggling between "Play With Synthesis" and "Play After Synthesis" modes for 

each track enables you to free up CPU usage. 

- Also available in ReWire(TM) 

 

-   Numerous easy-to-use functionalities newly implemented: 

- Automatic phoneme conversion of lyrics and automatic syllabication. 

- Randomization. 

- Automatic vibrato option. 

- Other helpful functionalities to increase speed of work. 

 

-   More flexible "activation" 

- LAN device not necessary. 

- Web-based offline activation available. 
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System Requirements 
 

Minimum System 

• Windows XP or Windows 2000. 

• Pentium III, 1 GHz or faster (To use ReWire™ or VOCALOID VSTi, Pentium 4 

1.8GHz or faster).  

• 512MB of RAM or more. 

• XGA Display (1024x768). 

• Sound Card. 

 

Recommended System 

• Windows XP. 

• Pentium 4, 1.8 GHz or faster. 

• I GB of RAM or more. 

 

Precautions & Notes 

 

• Activation of VOCALOID also requires that the computer is connected to the 

Internet, or you will need to have access to another computer that is connected to the 

Internet. 

• ReWire™ is a product or Propellerhead™ Software. ReWire and Propellerhead are 

trademarks of Propellerhead Software. 

• VST is a trademark of Steinberg Soft- und Hardware GmbH. 

• Windows is a trademark of the Microsoft Corporation. 

• Neither the Yamaha Corporation or its subsidiaries will respond to inquiries 

regarding this owner’s manual or the operation of this software. Please direct all 

inquiries to your local distributor or the developer of your specific software package. 
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Update & Activation 
 

Your current status is probably one of the followings. Please follow the procedure that 

matches your current status. 

 If VOCALOID has never been installed: 

1. Install the original package Version 1.0 (see the manual of the original 

package) 

After completing the installation, the activation dialog automatically appears, 

but click [NO] to cancel the activation. 

2. Update VOCALOID with this updater to Version1.1 

3. Activate VOCALOID 

 

 VOCALOID has been installed, but activation has not been completed: 

1. Update VOCALOID with this updater to Version 1.1 

2. Activate VOCALOID 

 

 VOCALOID has been installed and activated: 

1. Update VOCALOID with this updater to Version 1.1 

(You do not have to re-activate VOCALOID.) 

 

 

Update 
 
Please make sure whether your system meets all the conditions and necessary 

requirements before going to the following operation to update VOCALOID. You 

also need to make sure if the original VOCALOID package is installed properly. 

Close all the applications (especially VOCALOID editor) before you apply this 

updater.  

 

1. Double-click “vocaloid_update_1_1_0.exe”. The splash window should appear, 

then the VOCALOID Install Shield Wizard should be launched. 



 
 

2. The install wizard will show where to store the VOCALOID files. Click 

[NEXT].
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3. Next you will be asked whether you want to perform a complete or custom 

installation. In most cases you should select “Complete” and click [NEXT], allowing 

the install wizard to install the required files for you. If you do choose the “Custom” 

install option, you will be presented with a list of installable files that you can select 

as required: 

 

Files available for custom installation: 

File Description 

VOCALOID Editor The VOCALOID Editor application is essential to 

create VOCALOID sequences. You will need this 

file.  

VOCALOID VST instrument 

 

 

If you have a sequencing/recording application that 

is compatible with VST instruments you might 

want to install this plug-in. 
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4. Next the install wizard will ask where you want to install the VOCALOID VST 

instrument plug-in. Normally you will want to place it in the VSTi plug-in folder of 

your music application. If you don’t have a VST application or don’t know, simply 

ignore this step and click [NEXT].  

 

 
 

 

Activation 
Go on to this operation after applying this updater. 

(If you have already activated VOCALOID in Ver1.0, skip this operation.) 

 

1. Select “VOCALOID/Activate” from “All programs” of Start menu. The “Activate 

VOCALOID now?” dialog window will appear.  

Click[Yes] to go ahead. 
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Online activation 

Online activation is a method to get authorization key when the PC on which 

VOCALOID is installed (VOCALOID PC) is connected to the Internet. Off-line 

activation is also available for users who do not want to connect their VOCALOID 

PC to the Internet (see “Offline Activation,” below). After activation you will not 

need to connect your VOCALOID PC to the Internet or a network to use VOCALOID.  

 

2. Select “This PC has Internet connection” and press [Next] in the following dialog. 

 
 

3. Select one of the devices listed in the dialog (VOCALOID installed Hard Disk or 

active network devices on the PC) as a device to specify the PC.   Enter the 16-

character serial code included in your VOCALOID package and click 
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[Next].

 
 

If you get an “Invalid serial code” message check your serial code carefully and try 

again. 

 

If you select a network device, you will see a message “You should neither plug it out 

nor turn it inactive when you run Vocaloid.” will appear, but click [OK]. 

 

4. A dialog window showing the VOCALOID components to be activated will appear. 

Click [OK] to perform the activation. Your computer will automatically connect to 

the VOCALOID server and download the key required for permanent activation. 

 

 - 9 – 
 

Copyright 2005 by YAMAHA Corporation 
 



 
 

5. When the activation key has been successfully received from the server the 

“Activation successful” window will appear. Click [OK] to begin using your 

VOCALOID software. 

 

 
 

If the activation fails: 

Check your Internet connection and the serial number – e.g. make sure you 

haven’t entered a number from a different library package.  
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Offline Activation 
For offline activation you will need access to two computers: 

 

Computer 1: This is the computer on which you will install VOCALOID. It does not 

need to be connected to the Internet. 

 

Computer 2: This is the computer you will use for activation. It must be connected to 

the Internet (a dial-up connection is OK). 

 

Here is the offline activation procedure (following the activation step 1): 

 

2. The first option is selected for online activation by default, but for offline activation 

you will need to select the second option: “This PC has no Internet connection.” and 

click [Next]. 

 
 

3. Select one of the devices listed in the dialog (VOCALOID installed Hard Disk or 

active network devices on the PC) as a device to specify the PC. Enter the 16-

character serial code included in your VOCALOID package.  
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4. Click [Generate Auth Info file]. 

If you have selecte network device, you will see a message “You should neither plug 

it out nor turn it inactive when you run Vocaloid.”, but click [OK]. 
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5. The text file  “VOCALOID_ActivationInformation.txt” contains information about 

your PC hardware setup that is required for activation. Save this file to a floppy disk, 

USB memory, or other memory device and transfer the file to Computer 2 (the 

computer that is connected to the Internet). 

Leave Computer 1 running as it is. 

 

6. Access to VOCALOID offline activation site 

（http://www.vocaloid.com/en/activate/index.html）. 

 

7. Open “VOCALOID_ActivationInformation.txt” and copy and paste the content of 

the file to the activation window of the site.  

 
 

8. Click [Activate] button, and you will see the “File Download” dialog. Click [Save] 

to get the activation key file. 
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http://www.vocaloid.com/en/activate/index.html


 
 

9. Save the activation key file (“VOCALOID_ActivationKey.txt”). 

 

10. Copy the activation key file to a floppy disk or other memory medium and 

transfer it back  to Computer 1. Click [Import Activation Key] in the Offline 

Activation dialog and import the activation key file.  

 

11. Select the activation key file and click [Open] in the dialog. Activation will be 

automatically done.  

 

That completes the offline activation procedure. 

 

 

Activating Additional VOCALOID Libraries 

 

To add VOCALOID library Version 1.0, select “Custom” to install only vocal library 

and skin. Do not install VOCALOID Editor or VOCALOID VST instrument. If you 

have accidentally selected “Complete” or installed VOCALOID Editor or 
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VOCALOID VST instrument, update VOCALOID again with this updater.



Getting Started 
 

Launch the Application 
 

Double-click the “VOCALOID Editor” icon on your computer’s desktop to launch 

the VOCALOID Editor application. The first launch may take a little while in order to 

read vocal libraries during system start-up. The following progress dialog will appear, 

but please be patient. 

 
You will see “Vocaloid Singer Editor”. Select a singer to create a new sequence. 

 

Creating and Playing a Vocal Sequence – Basic Procedure 
 

Once you know the basic procedure, creating vocal tracks is actually quite easy. In 

this section we’ll show you the steps you might use to create a short vocal phrase. 

This is just one example, and once you are familiar with the way VOCALOID works 

you will undoubtedly find a procedure that works best for you. Also, since the actual 

results will depend on the specific VOCALOID library or libraries you are using, we 

can’t accurately predict how the example will sound, but this short exercise will get 

you started with the basics. 

 

Step 1: Create a New Sequence 
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When you launch the VOCALOID application,  a new “empty” sequence will 

automatically be created for you. If you have entered any data or made any changes, 

select “New” from the File menu (see 1-1. The Menus -> File). 

Step 2: Select a Singer 

 

When VOCALOID is launched, “Vocaloid Singer Editor” will automatically appear. 

You can select a singer from the list of installed singers. Also, when you try to create 

a new sequence file by selecting “New” from the File menu, “Vocaloid Singer Editor” 

will automatically appear. If you have only one singer, you can only select the singer, 

but you may want to adjust the way the singer sings. You can select “Singing Style” 

or change voice parameters of the singer in the dialog. 

The “Singing Style” selection has 5 styles such as Normal, Accent, Strong accent, 

Legato, and Slow legato (see 2-2. The Singer -> Customizing the singer’s voice). 

 

 
 

Step 3: Set the Initial Tempo and/or Time Signature 

 

While you are at the beginning of the sequence, take a look at the left edge of the 

rulers above the sequence window – MEASURE, TEMPO, and BEAT – and you will 

see the initial tempo and time signature settings at the beginning the TEMPO and 

BEAT rulers, respectively. You can double-click on either of these values to change 

their value as required (see 1-3. Sequence Window -> Rulers). 
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Step 4: Enter the Notes 

  

Click on the pencil tool button to select it (see 1-2. The Buttons & Indicators -> 

Tools). 

 

 
 

Then, starting at measure number 2 in the sequence track (you may need to drag the 

scroll bar to locate it), use the pencil tool to enter the notes so your sequence track 

looks like this: 

 

An example when an English library is used: 

 
 

An example when a Japanese library is used: 
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If you have a steady hand you can freely click and drag the notes to the required 

length, but it’s probably easier to use the VOCALOID Grid and the preset note 

lengths. (see 2-3. Entering & Editing Notes -> Grid vs. Length, 2-3. Entering & 

Editing Notes -> Entering and Editing Notes.) 

If the “Automatic Vibrato” option is selected and the note is long enough, vibrato will 

be automatically added. The Automatic Vibrato is ON by default.  You can also open 

the VOCALOID Icon Palette and add vibrato by drag & drop (see 1-1. The Menus -> 

Setting -> Vibrato).  

Phonetic symbols appearby default.   

 

Step 5: Enter the Lyrics 

 

Now let’s enter some lyrics for the notes we just entered. To prevent accidental note 

entry go back to the tool buttons and select the pointer tool. 

 

 
 

An example when an English library is used: 

Now we’ll enter the phrase “This is a pen” (don’t ask why). You should see the 

default lyric – “ooh” – above each note you entered. Double click the “ooh” above the 

first note to enter the lyric editing mode, then enter the first word “this”, and press 

[Tab] key to move to the next note. Repeat this for the remaining notes, entering one 

word per note. Your sequence should now look like the following figure:  

If the word has two or more syllables and there are enough notes, the word will be 

automatically syllabicated.  (see 2-4. Entering & Editing Lyrics ->Entering and 

Editing Lyrics.) 
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An example when a Japanese library is used: 

Now we’ll enter the phrase “ha ru ga ki ta”. You should see the default lyric – “a” – 

above each note you entered. Double-click the “a” above the first note to enter the 

lyric editing mode, then enter the first word “ha”, and press [Tab] key to move to the 

next note. Repeat this for the remaining notes, entering one word per note. Your 

sequence should now look like the following figure:  

You can also use Hiragana or Katakana other than Roman characters to enter lyrics. 

 
 

Step 6: Play – Initial Check 

 

Now you can play back your basic track to hear how it sounds and check that the 

phoneme transformation has produced the lyrics and pronunciation you had intended.  

 

For now move the sequence track to a position a bit before the first note in your track 

(do this by clicking briefly in the MEASURE ruler at the appropriate location (see 1-3. 

The Sequence Window -> Rulers), and then start playback by clicking the on-screen 

transport [Play] button , or by pressing the [SPACE] or [ENTER] key. The 

sequence will stop automatically when the end is reached, but you can also stop 
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playback at any time by clicking the on-screen transport [Stop] button , or by 

pressing the [SPACE] or [ENTER] key. 

(see 1-2. The Buttons & Indicators -> Transport, see 1-2. The Buttons & Indicators -> 

Show / Hide Start and End Markers.) 

 

Step7: Add Expression 

 

Now we’ll add some expression to make the track sound a little more life-like. Let’s 

use the sample “This is a pen” to see how to add expression now.  

If the icon palette is not already showing, select “VOCALOID Icon Palette” from the 

View menu (see 1-1. The Menus -> View). Now you can simply drag some basic 

expression objects to your vocal track. 

Start with attack: drag the “SLOW BENDUP” attack icon to the first note – when you 

drop the icon on the note you should see a little attack object at the beginning of the 

note, like this: 
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Now drag the “FAST BENDUP” attack icon to the last note. (see 2-6. Adding 

Expression) 

 

Step 8: Add Control 

 

This is the final touch to our first track – some real-time control. Start by selecting 

“Brightness” from the control menu, click the [FREE] control entry mode button (see 

1-4. The Control Track -> Control Input Mode Selectors), and use the pencil tool to 

draw a curve as close as possible to this one: 

 

 
 

Next select “Gender Factor” from the control menu and draw a curve as close as 

possible to the one shown here: 
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The control track is essential to the in-depth tweaking that can bring your vocal tracks 

to life. (see 2-7. The Control Track -> Editing a Control Track.) 

 

Step9: Play – Check the Expression 

 

OK, now play the track again and hear how it sounds. Better? 

The actual expressive variations produced by the expression icons and control 

parameters will depend on the VOCALOID library you are using, so it is not possible 

to accurately predict the results, but your vocal track should be sounding pretty 

interesting at this point. Now you can edit and tweak on your own to get a better feel 

for how the parameters interact with the voice. (see 2-2. The Singer -> Customizing 

the Singer’s Voice.) 

 

Step 10: Add a Track 

 

Although each VOCALOID track is strictly monophonic (notes cannot overlap), a 

VOCALOID sequence can have as many as 16 separate tracks. 
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Add a new track to your sequence by selecting “Add” from the Track menu (see 1-1. 

The Menus -> Track). You can now select either of the two tracks for editing by 

clicking the track selector tabs at the bottom of the sequence window (see 1-3. The 

Sequence Window -> Sequence Track). The track selector tab of the currently 

selected track is highlighted. 

 

 
 

For now, delete the track you just edited by first clicking its track selector tab and 

then selecting “Delete …” from the Track menu. Click [Yes] in the confirmation 

window to delete the track. 

 

Step 11: Copy Track 1 To Create a Chorus 

 

Here’s a quick and easy way to create a chorus. Select track 1 (the initial “This is a 

pen” track you created above), and select “Copy” from the Track menu. You will now 

have a new track containing the same data as your original track. 

 

The play mode of the copied track is “Play With Synthesis” by default. In this case, 

you may hear an intermittent play back because the synthesis engine synthesizes the 

wave form simultaneously during the playback, which increases CPU workload. If so, 

you should change the play mode. Left-click the round button of the track selector tab 

and select “Play After Synthesis” mode. (see 1-3. The Sequence Window -> Sequence 

Track -> Track Selector Tabs) In this case, the CPU workload does not increase 

because the synthesis engine synthesizes the whole waveform before the playback. 

You can also click [Synth/ReWire Prep.]  button to synthesize before 

clicking the [Play] button.  

 

The first thing you’ll want to do to create a chorus is select a different singer for the 

second voice (if you have one). Obviously a combination of different singers is going 

to sound more realistic than copies of the same singer. Next you can change the 

pitches of the notes to create harmonies by simply dragging them up or down the 
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appropriate pitches. Here’s a harmony track that works with our original “This is a 

pen” track: 

 

 
 

You will also probably want to adjust the second singer’s attack, vibrato, and other 

parameters to give him or her some individuality while maintaining the best possible 

musical blend. 

 

Step 12: Save Your Sequence 

 

When your masterpiece is complete you’ll want to save it for posterity. Select the 

“Save” item from the File menu and follow the standard file save procedure (see 1-1. 

The Menus -> File).
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Reference Section 
 

1. The Interface 
 

1-1. The Menus 
 

File 

 
 

With the exception of “Export,” the items in the File menu are pretty much standard 

and should be intuitive to use. 

 

New 

Create a new VOCALOID sequence file. When you select this function you 

will be asked if you want to save the current sequence file if it has been edited 

in any way. Select [YES] to enter a name for the current sequence (if 

necessary) and save it before opening a new file, [NO] to discard the current 

sequence and open a new file, or [CANCEL] to abort the operation. 

While opening the new file, “Vocaloid Singer Editor” will appear. Select a 

singer from the list(see 2-2. The Singer -> Selecting a singer). 
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Open 

Open an existing VOCALOID sequence file or standard MIDI file. When you 

select this function you will be asked if you want to save the current sequence 

file if it has been edited in any way. Select [YES] to enter a name for the 

current sequence (if necessary) and save it before opening another file, [NO] 

to discard the current sequence and open a different file, or [CANCEL] to 

abort the operation. 

 

Once you have saved or discarded the current sequence the standard open-file 

dialog will appear, allowing you to navigate to and open the desired 

VOCALOID sequence file. 

 

Import 

Add necessary track(s) from an existing VOCALOID MIDI file or a standard 

MIDI file to the current sequence. You can only import VOCALOID MIDI 

files created using VOCALOID Version 1.1. You cannot import VOCALOID 

MIDI files created with the previous version. The maximum number of tracks 

is 16. The play mode of the imported track is “Play With Synthesis”, but if 

there are 4 or more tracks of “Play With Synthesis” mode, the 5th track will 

become “Play After Synthesis” mode. 

You can select a singer at the beginning of each track. 

 

Save 

Save the current VOCALOID sequence file. If the file has been saved before, 

the file will be overwritten. If the file has never been saved, a standard save 

file dialog will appear. Specify the location to which you want to save the file, 

enter the file name, and click [SAVE]. 

 

Save As … 

Save the current sequence file using a new name, leaving the previously saved 

version untouched. Specify the location to which you want to save the file, 

enter the file name, and click [SAVE]. 
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Export > 

 Wave File 

This function exports the current sequence as a standard wave-format (WAV) 

audio file. The standard save-file dialog will appear: specify the location to 

which you want to save the wave file, enter a file name, and click [SAVE]. 

 

Recent File 

The name of the most recently created or opened file will be displayed here. 

Simply click the name to directly open the file. 

 

Exit 

Click “Exit” to exit from the VOCALOID Editor application. If the current 

sequence file has been edited in any way you will be asked if you want to save 

the current sequence file before exiting from the application. Select [YES] to 

enter a name for the current sequence (if necessary) and save it before exiting, 

[NO] to discard the current sequence and exit, or [CANCEL] to abort the 

operation. 

 

 



Edit 

 
 

The Edit menu items are fairly standard and should be familiar to anyone who has 

used a word processor or other music sequencer application. 

 

Undo 

This function can be used to “undo” the last edit operation in most cases. If 

you make an edit and then decide you want to undo it, be sure to use the Undo 

function immediately after performing the editing and before performing any 

other operation. The “Undo” item will not be available if the edit cannot be 

undone. 

 

Redo 

This item will “redo” a previously undone edit. So after making an edit you 

can use the Undo and Redo items to switch back and forth between the edited 

and pre-edit version for comparison … or simply to change your mind. Like 

the Undo function, Redo only applies to the last undone edit, and will not be 

available if there is no undone edit to redo. 

 

Cut 

Copy 

Paste 

The Cut, Copy and Paste editing commands are similar to the equivalent 

commands in most other applications, and can be used with objects in the 

 - 29 – 
 

Copyright 2005 by YAMAHA Corporation 
 



 - 30 – 
 

Copyright 2005 by YAMAHA Corporation 
 

sequence track and control track. “Cut” and “Copy” will cut or copy an object 

you have highlighted (single-click), or a group of objects you have highlighted 

by clicking and dragging with the pointer tool. There are, however, a few 

things to keep in mind. 

 

• When you cut/copy and then paste notes, dynamics objects or control-track 

objects, they will be pasted at the current position indicator location (the 

vertical orange line in the sequence and control tracks (It depends on the color 

configuration). 

• Please remember that notes and dynamics objects cannot overlap within the 

same track, and that any pasted control objects that overlap will be displayed 

as disabled. 

• Expression objects that are attached to specific notes – attack and vibrato – 

are not pasted to the position indicator location, but to a highlighted note. 

 

Select All 

Select all data objects in both the sequence track and the control track.  

You were able to select only notes in the previous version (Ver1.0), but this 

version (Ver1.1) allows you to select even invisible control parameters.   

 

Delete 

Deletes the currently selected data object(s). 

 

 



View 

 
 

The items in this menu what palettes and data types will appear or be hidden. A check 

mark will appear to the left of items that are currently showing. 

 

VOCALOID Icon Palette 

Shows or hides the VOCALOID Icon palette which provides access to a 

variety of attack, vibrato, dynamics, crescendo, and diminuendo types that can 

be applied to your sequence (see 2-6. Adding Expression  -> Adding 

Expression). 

 

VOCALOID Mixer 

Shows or hides the VOCALOID mixer window that contains mix controls for 

each individual track within the sequence as well as a master level control (1-4. 

The Control Track). 

 

Grid Line 

Shows or hides grid lines corresponding to the currently selected grid size in 

the sequence track. The grid lines can serve as a useful visual guide when 

entering or moving notes (see 2-3. Entering and Editing Notes  -> Entering 

and Editing Notes). 

 

Lyrics 
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Attack 



Phoneme 

Vibrato 

Dynamics 

These items all show or hide the corresponding data objects in the sequence 

track. These functions are duplicated by the corresponding buttons above the 

sequence track window (see 1-2. The Buttons & Indicators -> View Selectors). 

 

 

• Job 

 
 

The Job menu includes several functions: functions that can help eliminate overlapped 

notes and dynamics objects,  switching between VOCALOID’s basic and advanced 

dynamics programming modes, deleting / inserting bars, randomizing notes, etc. 

  

Normalize Notes … 

Resolves all instances of overlapping notes in the current track by shortening 

(truncating) the first note of all overlapping pairs. This function will not fix 

overlapping dynamics objects. 

 

Verify Data … 

Rather than resolving overlapping objects, this function simply searches the 

track and returns the location of the first note or dynamics object overlap it 

encounters so you can fix the situation as required. The position indicator will 

be automatically placed at the overlap location. 
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Dynamics Mode … 

 
Brings up a dialog window that lets you switch between the “Standard” or 

“Expert” dynamics mode. Select the mode you want to use and click [Go!]. 

In the “Standard” mode all dynamics changes are entered and edited via icons 

from the VOCALOID Icon Palette (the “Dynamics” control type will not be 

available in the control track). In the “Expert” mode the dynamics icons are 

disabled and in-depth dynamics editing can be performed via the control track 

(see 1-4. The Control Track).  

 

Insert Bars … 

 
You can specify the position and the number of bars to insert. You can insert 

from 1 to 32 bars. The inserted bar(s) will follow the same time signature in 

the bar before the inserted one(s).  

 

Delete Bars … 
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You can specify the start/end positions of the bars you want to delete. 

 

Randomize … 

 
Use this function to slightly shift the Note-on timing and/or the pitch in order 

to make the sound more realistic.  
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If “Note-on Shifting” is selected, it randomly changes note-on timing of all 

notes in the specified range. You can select how much you want to randomize 

notes from “Value” selection. 

If “Pitch Fluctuation” is selected, it adds pitch bend to the specified range to 

randomly change the pitch. You can select how much you want to randomize 

the pitch from “Value” selection. “Resolution” value determines interval 

between the pitch bend events to be added. The smaller the “Resolution” value, 

the smaller the interval will be, but 5 is the recommended value. You can 

select a pitch fluctuation pattern from the “Pattern” selection including 3 

different patterns and automatic selection. 

Click [Go!] button to activate the functions. 

 

Import ReWire Host Tempo 

Use this function to import the tempo setting from the host application to 

VOCALOID when you use ReWire™. Follow the procedure below: 

1. Start the host application and open an existing sequence file. 

2. Set the ReWire™ configuration at the host side. 

3. Start VOCALOID and set the output to ReWire™ 

4. Select “Import ReWire Host Tempo” from the Job menu 

5. Select “Interval” in the dialog. The default is 1/16. 

(If you select too small interval value such as 1 tick, you can get more 

precise tempo, but it will take too much time.) 

6. Press [Go!] button to start importing tempo to VOCALOID. If Start and 

End marker exist, tempo changes only between the Start and End marker 

will be imported. Otherwise, tempo changes of the whole sequence will be 

imported. 

 

* This function is not available for FL Studio™ and Logic™. If you use FL 

Studio or Logic, please manually set the tempo of both ReWire host and 

VOCALOID. 

 

 



Track 

 
 

A VOCALOID sequence can have up to 16 different tracks, allowing you to create 

entire choruses using a variety of “singers,” for example. The items in this menu 

provide access to a range of useful functions for managing your tracks. 

 

Track Manager 

“Track Manager” is a window where you can change settings for the tracks, 

such as changing track name(s), setting play mode, etc.  

There are 3 different play modes; “Play With Synthesis”, “Play After 

Synthesis” and “Off”. You can switch between those 3 modes for each track. 

 

If you left-click the round button in the “Mode” and select “Play With 

Synthesis” from the menu, the round button looks like this: . It means 

that, after the [Play] button is pressed, the track will be played while the 

synthesis engine synthesizes the waveform. If you select “Play After 

Synthesis”, the round button looks like this: . It means that, after the 

[Play] button is pressed, the whole track will be synthesized before actual 

playback starts. If you select “Off”, the round button looks like this: . 

It means that the engine does not synthesize the track. You can select the 

“Off” mode for a track that you do not want to play at the moment. You 

should select “Play With Synthesis” mode for tracks you are working on and 

“Play After Synthesis” mode for tracks you have already finished to optimize 

the CPU workload. Try to reduce the number of “Play With Synthesis” tracks 
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for you to work as effectively as possible. You can also change the play mode 

from the track selector tab (see 1-3. Sequence Window -> Sequence Track -> 

Track Selector Tabs).   

“Waiting Time” (in “Play With Synthesis” mode) is an interval between the 

moment when you press the [Play] button and the moment when the playback 

actually starts. The default value is 500 msec. If the sound becomes 

intermittent, you should increase the value. “Chase Event” should be checked 

to take into account all control events set before the song position. You should 

usually check this.   

 
 

Rename 

Allows a new name to be entered for the current track – the name in the track 

selector tab of the current track will switch to text-edit mode when this item is 

selected. You can also directly rename tracks by double-clicking the 

appropriate track selector tab. 
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Copy 

Creates a copy of the current track. The copy track will have the same name as 

the source track, followed by a number in parentheses. 

 

Add 

Creates a new empty track with the default track name. 

 

Delete … 

Deletes the current track. When this item is selected a confirmation dialog will 

appear allowing you to either proceed with the delete operation (click [YES]), 

or abort the delete operation (click [NO]). 

 

Overlay 

Determines whether or not you can see the notes in hidden tracks in the 

current track window. When this item is checked, notes in hidden tracks 

appear lightly shaded in the current track window. When the Overlay item is 

not checked you can only see the contents of the current track. 

 

 

Lyrics 

 
 

These functions are the keys to VOCALOID’s singing skill. They are used to 

transform the lyric text you type into sing-able data, and to edit the transformation 

rules so that the VOCALOID pronounces the lyrics the way you intended. 
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Phoneme Transformation 

This version (Ver1.1) automatically transforms the text lyrics into data 

(phonemes) that can be sung by the VOCALOID application when you enter 

or edit lyrics. Therefore, you do not have to select this menu normally. When 

you import/open a standard MIDI file, select this menu because the lyrics in 

the file are not automatically transformed into phonemes. (see 2-5. Phoneme 

Functions -> Phoneme Transformation). 

 

Phoneme Edit … 

Opens the Phoneme Edit window that allows you to edit the phoneme 

transformation rules for individual notes in your sequence (see 2-5. Phoneme 

Functions -> Phoneme Editing). 

 

User Word Dictionary 

Opens the User Word Dictionary for editing and addition of new words. 

VOCALOID comes with a basic dictionary that produces appropriate 

pronunciations for most lyrics, but the initial dictionary might not be able to 

transform all of the words you want to use in your lyrics. Any additional 

words can be entered in the VOCALOID User Word Dictionary so your 

freedom to enter lyrics is essentially unlimited (see 2-5. Phoneme Functions -> 

The User Word Dictionary). 

 

 



Setting 

 
 

This menu includes a number of settings that determine the basic operation and 

performance of the VOCALOID Editor application. 

 

VOCALOID MIDI > 

 Resolution … 

When the “Standard” dynamics mode is selected (see 1-1. The Menus -

> Job -> Dynamics Mode..) these parameters adjust the resolution, in 

clocks (480 clocks per quarter note) at which the dynamics and vibrato 

depth/rate changes will occur. If the changes sound uneven or 

“stepped” to you, try increasing the resolution (i.e. set a smaller 

number). The resolution parameters have no effect when the “Expert” 

dynamics mode is selected. 

 

 Option … 

The optional parameter here is “Pre-send Time.” In much vocal 

delivery a portion of the sound will appear a little before the beat. This 

is not syncopation, but rather to allow for the initial acoustic buildup of 

some sounds (“s” is a good example). In order to recreate such natural 

advanced sounds as realistically as possible, VOCALOID must send 

the triggering MIDI data to the VOCALOID synthesis engine a little 
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earlier than a conventional synthesizer would. This is the “pre-send” 

time, determined by this parameter. 

The “Pre-measure” parameter must be set to a value that is larger than 

the pre-send time, otherwise an error message will appear when you 

attempt to play the track. If you click “Adjust Pre-send Time” in the 

warning message window the pre-send time will automatically be 

adjusted (reduced) to fit within the available number of pre-measures. 

 

AUDIO > 

 Synthesis Engine … 

Here you have the sampling rate setting for the VOCALOID synthesis 

engine. The resolution is fixed at 16 bits. The available sampling rate 

settings will depend on the sound output device (normally your sound 

card) that you are using. 

The synthesized sound of this version (Ver1.1) is different from the 

one of Version1.0. If you want the same synthesized sound as in 

Version 1.0, select 1.0 in “Version” selection. If you change the 

“Version” setting, click [OK] and restart VOCALOID.  
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 Device … 

   
When the “Audio Device” radio button is selected, VOCALOID 

output is sent directly to your computer’s audio device. If you have 

more than one audio device installed you can select the one to which 

you want to send the VOCALOID output via the “Output Device” 

selection menu. The “Channel” parameter lets you select stereo or 

mono output. If you have intermittent playback or noise in the “Play 

with Synthesis” mode, please increase “Buffer Size” in the dialog. 

VOCALOID can be synchronized with any sequencer or music 

application that is compatible with ReWire™ protocol. In order to set 

up ReWire™ synchronization, start the host application first, launch 

VOCALOID, and select ReWire(Master) or ReWire(All Tracks) in the 

dialog (see 2-8. Using VOCALOID With Other Music Applications -> 

ReWire™ Synchronization) 

 
 

 - 42 – 
 

Copyright 2005 by YAMAHA Corporation 
 



 Wave … 

The parameters in this window specify details of the WAV file to be 

exported via the “Export …” item in the File menu (see 1-1. The 

Menus -> File).  The “Current” and “Master” radio button let you 

specify whether only the current track is exported (“Current”), or all 

tracks are exported as a single WAV file (“Master”). When "Mono" 

selected mono file is exported, although the output level of each track 

will depend on the setting of the pan control in the mixer window (see 

1-6. The Mixer Window -> The Mixer Window).  
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Pre-measure (f) … 

 
Allows you to specify from 1 to 8 “pre measures” – i.e. measures before 

measure 1 in the sequence window. Pre-measures are numbered with a minus 

(“-“) sign, and are necessary to allow for the pre-send data VOCALOID 

employs to synthesize realistic vocal phrasing. (see 1.1 The Menus -> Setting -

> VOCALOID MIDI -> Option…)  

 

Skin > 

Provides a list of the available “skins” that you can choose to change the 

appearance of the VOCALOID interface. The number and type of skins 

provided (if any) will depend on the supplier of your VOCALOID Library 

package. Changing skins has no effect on VOCALOID features or 

performance. 

 

Customize …  

Want to create your own color scheme for the sequence track? You can with 

this window. Simply click in the color boxes to choose the colors you want to 

use for the various parts. You have a choice as to whether you want to show 

the horizontal “black-key” stripes or not, and whether or not you want the 

vertical grid to show.  

 

Grid > 
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The “grid” makes it easy to enter notes right on the beat. You have a choice of 

note “sizes” from 1/4 notes to 64th notes, plus triplet variations of all available 

note sizes. When the grid is “OFF” you can position notes with maximum 

“clock” resolution (there are 480 clocks per quarter note). Convenient buttons 



and indicators are also provided for access to the Grid settings (see 2-3. 

Entering & Editing Notes -> Grid vs. Length). 

 

Length > 

“Length” adjusts alignment of the release of notes and expression objects 

entered in the sequence track. It therefore determines which beats the end of 

notes or expression objects will snap to when stretched. Convenient buttons 

and indicators are also provided for access to the Length settings (see 2-3. 

Entering & Editing Notes -> Grid vs. Length). 

 

Singer List … 

Brings up the "Vocaloid Singer Editor" with the available singer choices and a 

range of parameters you can use to customize the singer’s voice (see 2-2. The 

Singer -> Customizing the Singer’s Voice). 

 

Vibrato 

 
Allows you to set the automatic vibrato in this dialog. If “Automatic Vibrato” 

is checked, vibrato will be automatically added to a  note you have entered if 

the note is long enough. 

You can select the length of vibrato from 50%, 66%, 75%, or 100% in 

“Vibrato Length” pull-down menu. The default length is 66%. If the note 
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length is shorter than the length selected in “Minimum Note Length for 

Automatic Vibrato” pull-down menu, vibrato will not be added.     

The automatic vibrato is effective when you enter notes in the piano roll or 

when you import / open standard MIDI file, but it does not work when you 

copy & paste notes. 

 

Help 

 
 

Contents and Index 

Calls up the Contents and Index listings for the VOCALOID on-line help file. 

 

About VOCALOID Editor … 

Brings up the VOCALOID splash screen containing the version number and 

the URL of the VOCALOID web site. 

 

1-2. The Buttons & Indicators 
 

File Jobs 

 
 

These buttons provide direct access to three of the file jobs that are also available via 

the File menu – New, Open, and Save (see 1-1. The Menus -> File). 

 

 

Edit Functions 
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These buttons provide direct access to four of the file jobs that are also available via 

the Edit menu – Undo, Redo, Copy, and Paste (see 1-1. The Menus -> Edit). 

 

 

Tools 

 
 

These are the main tools you’ll use for selecting and editing data objects in the 

VOCALOID Editor. 

 

Pointer 

The pointer tool is used to select already-entered notes and control points for 

editing. You can use it, for example, to drag notes to different positions or 

beats, and in some cases double-clicking on a data object will bring up an edit 

window for that object. 

 

Pencil 

The pencil tool is used to enter new notes in the main data window, tempo or 

beat changes in the TEMPO and BEAT rulers, and controller data in the 

control track. The cursor automatically reverts to pointer mode when it is 

moved over the MEASURE ruler or any of the button or menu areas of the 

interface. 

 

Eraser 

As its name suggests, the eraser will erase any data object you click on. 

 

 

Note Values 
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Note Length 

When no note length is selected you can use the pencil tool to enter notes of 

any length (subject to the current Grid and Length settings --  see 2-3. Entering 

& Editing Notes -> Grid vs. Length) by simply clicking and dragging the 

notes as required. When a note length is selected (by clicking on the 

appropriate button), a note of the specified length will be placed at the point at 

which you click using the pencil tool. The currently selected note length can 

be deselecting by clicking its button a second time. 

 

Triplet 

Modifies the selected note length to produce triplets. For example, if you have 

select the eighth-note note length and also engage the triplet button, you can 

use the pencil tool to enter eighth-note triplets. 

The triplet button only becomes available when a note length is selected. 

 

Dotted Note 

Modifies the selected note length to produce dotted note values. A dotted note 

is 1.5 times the length of the un-dotted note. 

The dotted note button only becomes available when a note length is selected. 

Synth / ReWire Prep. 

 
 

This button has two functionalities. One is to synthesize “Play After Synthesis” track 

when you use VOCALOID as a stand-alone application. It is effective only for “Play 

After Synthesis” mode. Another functionality is to send the information of “Play With 

Synthesis” tracks to ReWire host when you use ReWire™. 

If there are “Play After Synthesis” tracks, you should press this button before pressing 

the [Play] button. Otherwise, you will have to wait for the engine to synthesize the 

“changed” tracks before the playback starts.  

When you use ReWire™ connection, press this button even if there are “Play With 

Synthesis” tracks in order to send the information of the track to ReWire™ host.  
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Show/Hide Start and End Markers 

 
 

These buttons individually show (activate) or hide (deactivate) the Start and End 

markers that you create by dragging them from the triangular position marker in the 

MEASURE ruler (If the marker is shown, the button is highlighted.) (see 1-3. The 

Sequence Window -> Rulers). The Start and End markers can be dragged from any 

point in the MEASURE ruler, without having to move the position indicator. The 

Start and End markers define the beginning and end points for repeat playback. 

  

Start 

Click to show or hide the Start [ ] marker. 

 

End 

Click to show or hide the End [ ] marker. 

 

 

Transport 

 
 

Similar to the transport controls on a tape deck (or just about any music sequencer 

program) these buttons let you play, stop, and move around within the sequence. 

 

To Top 

Click to go directly to the beginning (top) of the track. If the Start marker [ ] 

is showing you can jump directly to it by pressing the period [.] key on your 

computer keyboard. 
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Fast Reverse 

Rapidly scrolls backward through the track while held, or steps backward in 

one-measure increments if clicked briefly. 

 

Stop 

Stops playback. Playback can also be started and stopped by pressing the 

[SPACE] or [ENTER] key on your keyboard. 

 

Play 

Begins playback. If the [repeat] button (below) is not engaged playback will 

stop automatically at the end of the track. Playback can also be started and 

stopped by pressing the [SPACE] or [ENTER] key on your keyboard. 

 

Fast Forward 

Rapidly scrolls forward through the track while held, or steps forward in one-

measure increments if clicked briefly. 

 

To End 

Click to jump directly to the end of the track. 

 

Repeat 

When the [repeat] button is engaged playback of the track segment between 

the Start [ ] and End [ ] markers will repeat continuously until stopped by 

clicking the [ ] transport button or by pressing the [SPACE] or 

[ENTER] key on your keyboard. 

 

 

Grid 
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The “grid” makes it easy to enter notes right on the beat. You have a choice of note 

“sizes” from 1/4 notes to 64th notes, plus triplet variations of all available note sizes. 

When the grid is “OFF” you can position notes with maximum “clock” resolution 

(there are 480 clocks per quarter note). 

 

Size 

Select the size of the notes you want to align the grid to: 1/4, 1/8, 1/16, 1/32, 

1/64. If “1/8” is selected, for example, notes will snap to the nearest 8th-note 

beats when entered. 

 

Triplet 

When the triplet button is lit the currently selected note size becomes the 

corresponding triplet size. If “1/16” is selected, for example, and you engage 

the triplet button, notes you enter will fall on16th-note triplet beats. 

 

Grid Off  

When the Grid OFF button is engaged notes can positioned with maximum 

resolution – 480 clocks per quarter note. 



Length 

 
 

“Length” adjusts alignment of the release of notes and expression objects entered in 

the sequence track. It therefore determines which beats the end of notes or expression 

objects will snap to when stretched. 

 

Size 

Select the beats you want to align releases to: 1/4, 1/8, 1/16, 1/32, 1/64. If 

“1/8” is selected, for example, the ends of all notes and expression objects will 

be aligned to the nearest 8th-note beats. 

 

Triplet 

When the triplet button is lit the currently selected note size becomes the 

corresponding triplet size. If “1/16” is selected, for example, and you engage 

the triplet button, releases will be aligned to the nearest 16th-note triplet beats. 

 

Length Off  

When the Length [OFF] button is engaged no alignment occurs and the ends 

of notes and expression objects can be positioned with maximum clock 

resolution. 

 

 

Coordinate Indicators 

 
 

These two values tell you exactly where your cursor is located in the VOCALOID 

sequence track. 

 

 - 52 – 
 

Copyright 2005 by YAMAHA Corporation 
 



X 

The “X” coordinate indicates horizontal position along the sequence track (see 

1-3. The Sequence Window -> Sequence Track). The position is indicated by 

three values separated by commas – Measure : Beat : Clock. The first value is 

the number of the current measure, the second value is the beat as determined 

by the time signature set in the BEAT ruler, and the third value is the current 

clock position within the beat (there are 480 clocks per quarter note). 

 

Y 

The “Y” coordinate indicates the note over which the cursor is currently 

positioned (i.e. the vertical direction). The notes range from C-2 to G8. 

 

 

Tempo Indicator 

 
 

Shows the current sequence tempo. The initial tempo and subsequent tempo changes 

can be entered and edited in the TEMPO ruler (see The Sequence Window -> Rulers). 

 

 

View Selectors 

 
 

These buttons perform the same functions as the corresponding items in the View 

menu (see 1-1. The Menus -> View), letting you show or hide the LYRICS, 

PHONEME, ATTACK, VIBRATO, or DYNAMICS data in the sequence track. 
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1-3. The Sequence Window 
 

 
 

Rulers 
 

The “rulers” across the top of the sequence track display and control the track’s time-

based functions. 

 

Measure 

The orange triangle (The color depends on the color configuration) and line 

extending down from the MEASURE ruler are the track’s position indicator. 

The indicator will scroll along the track during playback to indicate the current 

playback position. You can move the position indicator to any point in the 

track simply by briefly clicking in the MEASURE ruler at the desired location. 

The position indicator will also jump to positions specified by operation of the 

transport [ ], [ ], [ ] or [ ] controls. The Start [ ] and 

End [ ] markers (see 1-2. The Buttons & Indicators -> Show/Hide Start and 

End Markers) used to define the repeat playback limits also appear in the 

MEASURE ruler. The Start [ ] and End [ ] markers can initially be placed 

by clicking the position pointer triangle and dragging along the MEASURE 

ruler to the desired locations (the Start [ ] marker will always precede the 

End [ ] marker). The Start and End markers can also be dragged from any 

point in the MEASURE ruler – without having to move the position indicator 

– after clicking and holding for a second. 

 

Tempo 

The initial tempo and subsequent tempo changes can be entered and edited in 

the TEMPO ruler. To edit the initial tempo setting at the very beginning of the 

TEMPO ruler, double click on it and then edit it’s value in the window that 
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appears. Click [OK] to confirm and enter the tempo change or [CANCEL] to 

abort. 

 To enter a tempo change later in the track, click at the appropriate 

location in the TEMPO ruler with the pencil tool. The tempo window will 

appear allowing you to enter a new tempo value which will be entered at the 

point at which you clicked the pencil tool when you click the window’s [OK] 

button. You can also set the precise position of the tempo change using the 

“Position” parameters in the tempo window (measure, beat, and clock). 

 
 

Beat 

The initial time signature and subsequent time signature changes can be 

entered and edited in the BEAT ruler. To edit the initial time signature setting 

at the very beginning of the BEAT ruler, double click on it and then edit the 

upper and lower values in the window that appears. Click [OK] to confirm and 

enter the beat change or [CANCEL] to abort. 

 To enter a time signature change later in the track, click at the 

appropriate location in the BEAT ruler with the pencil tool. The time signature 

window will appear allowing you to enter new time signature values which 

will be entered at the point at which you clicked the pencil tool when you click 

the window’s [OK] button. You can also set the precise position of the time 

signature change using the “Position” parameters in the time signature 

window. 
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Right-click Tip: Right-click on the MEASURE, TEMPO, or BEAT ruler for 

conveniently accessible Grid (see 1-2. The Buttons & Indicators -> Grid), Length (see  

1-2. The Buttons & Indicators ->  Length), and Marker (see  1-2. The Buttons & 

Indicators -> Show/Hide Start and End Markers) menu items. 

 

 

Keyboard 
 

The graphic piano keyboard is a visual guide for note entry. Each key corresponds to 

a band in the sequence window to the right of the keyboard – white bands correspond 

to white keys and gray bands correspond to black keys.  
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Sequence Track 
 

This is where you actually enter the notes and lyrics to be “sung” by VOCALOID. 

You begin by entering the desired notes of the desired length. The default lyric is 

automatically entered for each note (“Ooh” when entering English, for example). You 

can then click on and edit the default lyric for each note to create the desired phrase 

(see 2-4. Entering and Editing Lyrics  -> Entering and Editing Lyrics). After 

“Phoneme Transformation” (see 2-5. Phoneme Functions -> Phoneme 

Transformation) VOCALOID will be able to sing the lyrics you have entered – 

although you’ll have to add dynamics and phrasing control to make the resultant vocal 

track sound realistic (see 2-6. Adding Expression  -> Adding Expression). 

 

Scroll Bars 

The horizontal and vertical scroll bars along the bottom and right edges of the 

sequence window perform essentially the same functions that they do in a 

word processor or other program: i.e. click the arrows to scroll in the 

corresponding direction, or drag the scroll handle to move to the desired 

location. 

 

Zoom Buttons  

The [ ] and [ ] zoom buttons zoom in or out on the track horizontally. 

Zoom in for fine note positioning, for example, or out to see a broader overall 

view of the track.  

 

Track Selector Tabs 

Track selector tabs for all tracks you have created in your VOCALOID 

sequence will appear here. Select a track for editing or viewing by clicking the 

corresponding tab. The track selector tab of the currently active track will be 

highlighted. Double-click a tab to edit the track name. 

 

Right-click Tip: Right-click on any track tab to conveniently access the Track 

menu items (see 1-1. The Menus -> Track). 
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You can also left-click the round button on the track selector tab to select play 

mode from the menu as follows. You cannot change play mode during the  

playback.  

 
 

Track Scroll Buttons 

If you have created a number of tracks, not all of them may be visible in the 

track selector tab area at the same time. Use the track scroll buttons to scroll 

the desired track tab into view ([ ] and [ ]), or to jump to the beginning or 

end of the track selector tabs ([ ] or [ ]). 

 
Right-click Tip: Right-click in the sequence track for conveniently accessible tool 

selection (see 1-2. The Buttons & Indicators -> Tools), note length selection (see 1-2. 

The Buttons & Indicators ->  Length), and edit items (see 1-2. The Buttons & 

Indicators -> Edit Functions). 
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1-4. The Control Track 
 

In addition to specifying the initial singer and singer changes during the sequence, the 

control track is where you view and edit all other parameters that control the sound of 

the notes in the sequence track: note velocity, singer parameters such as resonance 

and harmonics, pitch bend, and more. 

 

 
 

Control Select 
 

Click the arrow [ ] to see the control menu, from which you can select the control 

parameter to be displayed in the control track. You can only select one control 

parameter to be displayed in the control track at a time, but all programmed parameter 

changes are active at all times. Select the parameter you want to view or edit. The 

name of the currently selected parameter will appear in the control select bar. 

 

When the mouse pointer is located in the control track region, you can switch the 

control parameter by pressing “PageUp” key or “PageDown” key. 
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Value 
 

The current value of the selected control point or parameter is displayed in the 

VALUE bar, and you can use the up and down arrows to the right of the value to set 

the value as required. You can directly edit the value numerically by double clicking 

the currently displayed value, entering a new value, and pressing [ENTER] on your 

keyboard. Values can also be edited by directly clicking and dragging the control 

points in the control track. 

 

 

Interval 
 

This parameter determines the spacing or “interval” of the control points generated by 

“free” or “line” input, below. The interval parameter can be set from 1 to 999 clocks 

(there are 480 clocks per quarter note). 

 

 

Control Input Mode Selectors 
 

A variety of input modes are provided for the control track. Choose the mode that 

most easily produces the type of control change or curve you need. In addition to 

drawing dots, curves and lines using the pencil tool, you can use the standard edit-

menu functions to, for example, copy and paste a control curve from one location on a 

track to another (see 2-7. The Control Track -> Editing a Control Track for edit 

function details). 

 

Dot 

The dot mode allows you to enter single control values individually by 

clicking to place a “dot” at the desired location in the control track. This 

method is ideal for creating abrupt control value changes, although you can 

enter multiple dots to approximate lines or curves. The interval parameter 
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(above) does not affect the dot input mode, and you can place dots with 

maximum resolution. 

 

Free 

The free input mode allows you to click and drag to create virtually any 

control curve you like. This method is best when you want to create complex 

control changes. A shaded curve corresponding to the curve you have drawn 

will appear while you are dragging, then the control points required to 

approximate the curve will be created automatically when you release the 

mouse button. The spacing of the control points is determined by the setting of 

the interval parameter, above.  

 

Line 

When you click and drag in the control track when the line mode is selected 

you will see a “rubber band” line connecting the point at which you initially 

clicked and the point at which you drag to. A straight line composed of 

multiple control points will automatically be created when you release the 

mouse button. The spacing of the control points is determined by the setting of 

the interval parameter, above. 

 

 

Right-click Tip: Right-click in the control track for conveniently accessible tool 

selection (see 1-2. The Buttons & Indicators -> Tools) and edit items (see 1-2. The 

Buttons & Indicators -> Edit Functions). 

 

 

1-5. The Icon Palette 
 

This is a small movable floating palette that will appear in the display area when the 

VOCALOID Icon Palette item in the View menu is checked. The window can be 

dismissed either by clicking the close box in its upper right corner, or by clicking the 

VOCALOID Icon Palette item in the View menu a second time. The VOCALOID 



Icon Palette provides access to a variety of attack, vibrato, dynamics, crescendo, and 

diminuendo types that can be applied to your sequence (see 2-6. Adding Expression  -

> Adding Expression).  

 

 
 

Right-click Tip: Right-click on any icon in the icon palette for a Property item that 

lets you view information about the selected icon. 
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1-6. The Mixer Window 
 

Like the Icon Palette, the VOCALOID Mixer window is a movable floating window 

that will appear in the display area when the VOCALOID Mixer item in the View 

menu is checked. The window can be dismissed either by clicking the close box in its 

upper right corner, or by clicking the VOCALOID Mixer item in the View menu a 

second time. The Mixer window provides mix controls for each individual track 

within the sequence as well as a master level control. A numbered track fader module 

will automatically be created for each track in your VOCALOID sequence. 

 

 
 

Track Fader 
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Each track fader module includes a linear fader for independent level control 

of the corresponding track. Drag the fader up or down to adjust the level of the 

corresponding track. The heavy line on the fader scale indicates normal 

(nominal) level (0 dB). The fader scale ranges from –89.8 through 0 to +5.5. 

When the fader is highlighted the current fader level is shown in the numeric 
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level indicator immediately below the fader. You can also set the fader level 

numerically by double-clicking the level indicator and editing the value as 

required. 

 

Pan Control 

The pan control for each track is the small horizontal “L—R” slider above the 

fader. Drag the slider to the left or right to pan the signal from that track to the 

corresponding side of the stereo output. When the pan control is highlighted 

the pan position is indicated numerically in the level indicator. Numerically 

the pan range is from –64 (full left) through 0 (center) to +64 (full right). You 

can also set the pan position numerically while the pan control is highlighted 

by double-clicking the level indicator and editing the value as required. 

 

Mute Button 

Click the [MUTE] button at the top of any module to turn output from that 

track off. Click again to disengage the MUTE function. “MUTE” appears in 

the fader level indicator when MUTE is engaged. 

 

Solo Button 

The SOLO function allows “solo monitoring” of individual tracks. If you have 

created a number of tracks but want to listen to the output of just one, for 

example, you can simply engage the [SOLO] button for that track rather than 

having to individually mute all of the other tracks. When the SOLO function is 

engaged “SOLO” will appear in the fader level indicator for that track, while 

“MUTE” appears in the fader level indicators of all other tracks. Click the 

[SOLO] button a second time to disengage the SOLO function. 

 

Output Assign 

The indicator/selector at the bottom of each track module assigns the output of 

that track to either the master fader (on the right side of the Mixer window) or 

ReWire™-enabled tracks in another application. The indicator selector at the 

bottom of the MASTER module assigns the overall mix output to either your 

computer’s sound output device or ReWire™ (see System Requirements -> 



Precautions & Notes). If you select “ReWire(Master)”, all tracks are mixed 

down by VOCALOID mixer and sent to ReWire™ host. If you select 

“ReWire(All Tracks)”, each track is individually sent to ReWire™ host.  

 

Master fader Module 

The master fader in the fader module controls the overall output level of all 

VOCALOID tracks that are assigned to “Master.” Operation of the master 

fader, fader level indicator, and all other controls in the master fader module is 

the same as the corresponding controls in the track fader modules. 
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2. Operation 
 

2-1. Play mode  
There are 3 different play modes; “Play With Synthesis”, “Play After Synthesis” and 

“Off”.  

“Play With Synthesis” mode means that, after the [Play] button is pressed, the track 

will be played while the synthesis engine synthesizes its waveform. If you add a track, 

it is set to “Play With Synthesis” mode by default. The maximum number of “Play 

With Synthesis” mode tracks is 4 per sequence. If more tracks are added, they are set 

to “Play After Synthesis” mode.   

 “Play After Synthesis” mode means that, after the [Play] button is pressed, the whole 

track will be synthesized before actual playback starts. You should set “Play After 

Synthesis” mode for tracks you have finished to optimize the CPU workload. 

In order to change play mode, select “Track Manager” from the Track menu and left-

click the round button of each track in the dialog. You can also change play mode 

from the menu displayed by left-clicking the round button in the track selector tab. 

You cannot change mode during playback. 

 
 
 
2-2. The Singer 
 

The singer is a vocal “entity” defined by the VOCALOID Library that will sing the 

notes and lyrics you enter. The singer can be male, female, and speak just about any 

language, as defined by the VOCALOID Library you are using. The VOCALOID 

Library you have purchased will include one or more singers, and you can add other 

singers by adding optional voice libraries as they become available. 
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Selecting a Singer 
 

When you launch VOCALOID Editor or create a new sequence / track, the following 

“Vocaloid Singer Editor” will appear. You can set a singer for the new track. 

“Vocaloid Singer Editor” window has a singer list and a series of parameters to 

customize the singer’s voice. 

After you select the singer by clicking the singer’s name and click the [OK] button,   

the selected  singer will be automatically entered at the beginning of the control track 

(including pre-measures) (see 1-4. The Control Track -> The Control Track). The 

singers that are available for selection depend on the VOCALOID Library you are 

using. You can change the singer to any other available singer by selecting “Singer” 

from the Control Select menu and double clicking on the singer icon at the beginning 

of the control track. This will bring up the singer menu with the available singer 

choices and a range of parameters you can use to customize the singer’s voice.  
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Changing Singers During the Sequence 
 

You can change the singer at any point in the sequence, as many times as you like, by 

using the Pencil tool to enter a new singer in the control track: make sure “Singer” is 

selected from the Control Select menu, then click the Pencil tool at the point in the 

control track you want the change to occur. This will once again bring up the singer 

menu from which you can select the singer to be inserted. The new singer icon will 

appear in the control track when you click the [OK] button in the singer menu 

window. 

 

 
 

 

Customizing the Singer’s Voice 
 

Using the singer “as is” will produce characteristics most closely resembling the 

sound of the singer who created the databases you are using. You can, however, 

change a number of parameters to vary the voice over a fairly wide range. The most 

important use of these parameters, however, is in applying real-time variations via the 

control track that can “animate” your vocal tracks and simulate the expressive 

delivery of a live singer. 

This version (Ver1.1) lets you select “Singing Style”. 

Each voice in the singer list has its own set of voice parameters that are displayed in 

the Voice Parameters sub-window when a singer is highlighted (single click) in the 

list. All parameters in the Voice Parameters sub-window in the singer window have a 

0 ~ 127 range. The [RESET] button resets all parameters to their default settings. You 

can edit parameter values by either clicking the increment or decrement arrows to the 

right of each value, or use normal text-editing procedures to directly edit the value. 

Changes will take effect after you close the Singer window. 
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Singing Style  

There are 5 styles for singing: Normal, Accent, Strong accent, Legato, and 

Slow legato. By selecting a different style for the same singer, you can even 

create different characteristics for expanded expressive capability. 

 
Harmonics 

Boosts or reduces the harmonics of the voice. In addition to changing the 

sound of the voice to a certain extent, since the level of the voice’s harmonics 

are being boosted or cut this has the overall effect of making the voice sound 

louder or softer. 

 

Noise 

Higher values add noise to the voice, producing a harsher sound. Lower values 

produce cleaner, pure-sounding tones. 

 

Brightness 

Boosts or cuts the voice’s high-frequency content. Higher values produce a 

brighter, more “present” sound, while lower values produce a more mellow 

effect. Lower values can effectively simulate gently delivered or even 

whispered phrases. 

 

Clearness 

The effect of this parameter is similar to the “Brightness” parameter described 

above, but the timbre of the voice is affected in a different way. Higher values 
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produce a sharper, clearer sound while lower values produce a more muted 

sound. 

 

Gender Factor 

Shifts the formant structure of the voice, changing the voice’s character over a 

broad range. Higher values produce deeper, male timbres, while lower values 

can sound more female or, in some cases, more “chipmunk-like.” 

 

Resonance 1 ~ 4 

The four Resonance blocks in the singer window can be set to statically shape 

the resonance of the voice, or each of the four blocks can be individually 

controlled via the control track for dynamic timbral control. 

 

Each Resonance block has a Frequency parameter that specifies the center 

frequency of the frequency band to be affected (higher value = higher 

frequency), a Band Width control that adjusts the width of the frequency band 

to be adjusted (higher value = broader bandwidth), and an Amplitude 

parameter that specifies the amount of boost or cut (values higher than 64 

boost while values lower than 64 cut). 

 

 

Adding and Copying Singers 
 

You can use the [Add New Voice] and [Copy Voice] buttons in the singer window to 

create new versions of the available voices that you can simply select and use when 

required. 

 

When you click [Add New Voice] you can create a new voice based on an original 

voice provided with your VOCALOID Library. Use the “Program Change” parameter 

to select a new program change number from 0 to 127 for the voice to be added (each 

voice must have a different program change number), select a singer from the 

VoiceName menu, and click [OK] to add the voice. You can then edit the voice name 

by clicking on it in the singer list. Any parameter changes you make for the new voice 



will be retained with the voice so you can simply select and use the variations you 

create whenever you need them. 

 
 

The [Copy Voice] button lets you copy an original or edited voice, using a new 

program change number and voice name. 

 
 
If you click the position where you want to change the singer in the control track 

region, the Singer Editor will appear. You can use the saved singer as many times as 

you like by selecting from the Singer Editor. 

 

You can also delete the selected singer voice from the list by clicking the [Inactivate 

Voice] button. 
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2-3. Entering & Editing Notes 
 

You begin the creation of any VOCALOID sequence by entering the notes and lyrics 

to be “sung.” The very first step is to enter the desired notes (pitches) of the desired 

length. Notes are entered at the desired locations in the VOCALOID sequencer track 

(see 1-3. The Sequence Window -> Sequence Track) using the pencil tool. When no 

note length is selected you can use the pencil tool to enter notes of any length at any 

location in the track (subject to the current Grid and Length settings –  see 2-3. 

Entering & Editing Notes -> Grid vs. Length) by simply clicking and dragging the 

notes as required at the appropriate pitches. The pitches of the horizontal bands in the 

sequence track correspond to the keys on the graphic keyboard to the left of the track. 

Duration can be judged by keeping an eye on the MEASURE ruler across the top of 

the track. The current position (measure:beat:clock and pitch) of your cursor is also 

shown by the X and Y coordinate indicators above the sequence track. 

 

 
 

When a note length is selected (by clicking on the appropriate note-length button), a 

note of the specified length will be placed at the point at which you click using the 

pencil tool (also subject to the current Grid setting). The currently selected note length 

can be deselected by clicking its button a second time. 
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Use either or both of these methods to enter the basic notes to be sung by your singer, 

leaving appropriate spaces for rests. Keep in mind, however, that notes in the same 

track cannot overlap. 

 

Deleting Notes 
 

Notes you have entered can be individually deleted either by clicking them with the 

eraser tool, or single-clicking to highlight with the pointer tool and then pressing the 

[Delete] key on your computer keyboard. You can specify a range of notes to be 

deleted by clicking and dragging with the pointer tool to highlight all of the desired 

notes. 

 

Stretching Notes 
 

Individual notes can be stretched to make them longer (as long as doing so doesn’t 

cause them to overlap another note) or shorter as required. The Length setting (see 1-2. 

The Buttons & Indicators -> Length) determines the beats to which the note release 

will snap when a note is stretched. Place the pointer tool over the end of a note (not 

the beginning of the note) so that the red double-ended arrow stretch symbol appears 

( ), then click and drag the note to resize as required. 

 

 
 

Moving Notes 
 

Position the pointer tool over the body of a note and it will change to the hand pointer 

which you can use to click and drag the note to a different horizontal position (as long 

as it doesn’t overlap another note), or to a different pitch. You can also use this 

method to move a group of highlighted notes. The Grid setting (see 1-2. The Buttons 

& Indicators -> Grid) will determine to which beats the moved note(s) will snap. 
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Copying Notes 
 

You can copy single notes or a group of highlighted notes to a different location (time 

and/or pitch) by grabbing and dragging with the hand pointer while holding the [Ctrl] 

key on your computer keyboard. As with the move operation described above, the 

Grid setting (see 1-2. The Buttons & Indicators -> Grid) will determine to which beats 

the copied note(s) will snap. 

 

 
 

You can also use the standard edit commands – cut, paste, and copy (see 1-1. The 

Menus -> Edit) – to copy or cut and paste single or multiple notes. In this case the 

notes will be pasted to the current location of the position indicator.       

 

Grid vs. Length 
 

At first the Grid and Length functions (see 1-2. The Buttons & Indicators -> Grid vs. 

Length) may seem similar, and therefore somewhat confusing. Actually, they are very 

similar in that they align notes and expression objects in the sequence track to the 

nearest specified beats, but the difference is in whether that alignment applies to the 

beginning (attack) or to the end (release) of the notes/objects.  

 

The Grid setting affects where the beginnings of the notes or expression objects will 

be placed in the sequence track. If you want all notes you enter to fall precisely in 8th-

note beats, for example, make sure the Grid is ON and is set to 1/8. Then when you 

use the pencil tool to enter a note it’s attack will precisely snap to the nearest 8th note 

beat even if your aim is a little off. 
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The Length function, however, applies to the ends (releases) of notes and expression 

objects. Length therefore determines the beats to which the ends of notes or objects 

will snap when click-and-drag entered or stretched.  

 

 



2-4. Entering & Editing Lyrics 
 

The default lyric is automatically entered for each note (“Ooh” when entering English 

and “a” when entering Japanese, for example). You can then double-click on and edit 

the default lyric for each note to create the desired phrase. You can press the [TAB] 

key to jump directly to the next note after entering the text for a note. The text lyrics 

are automatically transformed into phoneme data the VOCALOID can “sing”. 

 

When you sing an English song, you may notice that a single word with one syllable 

corresponds to a single note, while one with multiple syllables is sung across several 

notes, one syllable per note. One syllable also can be sung across multiple notes. 

 

 

Once you enter a word with one syllable, the text lyric will be automatically 

transformed into phoneme data. When you enter a word with multiple syllables, the 

word will be automatically divided into syllables and transformed into phoneme data 

if there are enough notes afterwards. 

 
 

In the above example – “She’s such a lady” – the first three words (“She’s such a”) 

correspond to individual notes, while “la-dy” is automatically divided into two notes: 

the “la-” syllable on the first and the “dy” syllable on the second. 

 

(a) In order to sustain a syllable of a word,  simply type a hyphen following the vowel 

of the syllable and a hyphen to each subsequent note until the next syllable. 

 
 

 - 76 – 
 

Copyright 2005 by YAMAHA Corporation 
 



 

(b) In order to stretch the last syllable of the word, type a hyphen following the vowel 

of the syllable and a hyphen to each subsequent note and a slash on the last note. 

 
 

 

Japanese can be entered using Romaji (Roman characters), Hiragana, or Katakana 

input methods. 

 

 

 

Although you enter  Japanese lyrics for a Japanese singer, please note that any lyrics 

that have been entered in Romaji is still  sung using Japanese pronunciation. 

 

At this stage the vocal track will still sound rather mechanical, and you’ll have to add 

dynamics and phrasing control to make the track sound realistic. 
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2-5. Phoneme Functions – Making VOCALOID Sing 
 

“Phoneme” is a linguistics term that refers to a small set of speech sounds that are 

distinguished by the speakers of a particular language. The VOCALOID phoneme 

functions – transformation and editing – are the critical functions that turn typed lyric 

text into synthesis data that sounds like natural vocals when played back. 

 

Phoneme Transformation 
 

When you have entered the lyric text, or edited the lyric text at any stage during the 

creation of your vocal track, the entered lyrics will be automatically transformed to 

the proper pronunciation. When SMF (standard MIDI file) is imported, however, the 

automatic transformation is not performed. Please do this by clicking the “Phoneme 

Transformation” item in the Lyrics menu. In case the Phoneme Transformation does 

not work properly, the entered word may not be registered in the User Dictionary or 

the number of notes may not correspond to the number of syllables. Please check your 

spelling carefully and make sure that there are enough notes.  

 

Phoneme Editing 
 

If the normal phoneme transformation doesn’t produce the pronunciation you require, 

you can use the Phoneme Editor to change the actual phoneme transformation result 

for the problem note(s). 

 

To use the Phoneme Editor first click on and highlight the note corresponding to the 

lyric you want to alter, then open the Phoneme Edit window by selecting the 

“Phoneme Edit …” item in the Lyrics menu. 

 



 
 

The phonetic data for the note you highlighted in the sequence track will be 

highlighted in the Phoneme Edit window (if you selected more than one note, the data 

for the first note will be highlighted). Normally you will want to change the phonetic 

symbol or symbols used to describe the pronunciation of the corresponding lyric. To 

do this simply double-click the phonetic symbol and edit the symbols as required 

while referring to the reference chart on the right side of the window (each phonetic 

symbol in the chart is accompanied by a pronunciation sample). Each note/lyric may 

require one or more phonetic symbols to describe its punctuation. When more than 

one phonetic symbol is required the symbols must be separated by spaces. When the 

phonetic symbols have been edited as required press the [ENTER] key on your 

keyboard to actually enter the change. When this is done the PROTECT checkbox to 

the right of the lyric will automatically be checked to prevent the edited pronunciation 

from reverting to the default pronunciation if an overall phoneme transformation is 

executed later. 
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A more direct way to edit the phonetic symbols is via the symbols displayed below 

each note in the sequence track when the PHONEME view button is engaged: double 

click the symbol below a note, enter the change, and press [Enter] on your computer 

keyboard. Protect is automatically applied to changes you make in this way, and you 

will need to enter the phoneme editor to remove protection if necessary. 

 

 
 

At times you might want to adjust the length of some consonant sounds – “s” or “f” 

are often-encountered examples – to fine-tune your phrasing. You can do this via the 

[Setup] button in the phoneme edit window. Select the phoneme that includes the 

consonant you want to adjust, click [Setup] in the next window. You can now click on 

and adjust any of the consonants in the selected phoneme. The normal default value 

for all consonants is “64”. Lower values shorten the consonant, while higher values 

(up to 127) lengthen it. 
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A handy phonetic symbol and pronunciation sample chart is provided in the Appendix 

of this manual (see 3-1. Phonetic Symbol Chart). 

 

If one note includes multiple syllables, click the word in “Phoneme Edit” dialog so 

that you can slide the position of the syllable horizontally in the “Phoneme Parameter 

Setup” dialog.   

 
 

The User Word Dictionary 
 

This dictionary setting function is available for only English library. VOCALOID 

comes with a basic dictionary that produces appropriate pronunciations for most lyrics, 

but the initial dictionary might not be able to transform all of the words you want to 

use in your lyrics. Any additional words such as a little-known place name can be 
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entered in the VOCALOID User Word Dictionary so you have unlimited freedom to 

expand VOCALOID’s vocabulary to match your lyrical requirements. 

 

Open the VOCALOID User Word Dictionary by clicking the “User Word Dictionary” 

item in the Lyrics menu (see 1-1. The Menus -> Lyrics). 

 

 
 

Create a New User Dictionary 

 

Select (new) from the drop-down “User Dictionary” list at the top of the User Word 

Registration window, enter an appropriate dictionary name in the Create User 

Dictionary dialog that appears, then click [CREATE]. 
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Add New Words and Pronunciations 

 

Once you have created a new user dictionary or selected a previously-created user 

dictionary you can add new words and pronunciations as required. Type your word 

into the “Word” space. If the [AUTO] button is engaged the appropriate phonetic 

symbols will automatically be generated and entered in the “Pronunciation” space for 

you. You can then edit the phonetic symbols as required if the automatically 

generated symbols don’t produce the desired results. If the [AUTO] button is not 

engaged when you enter your word, you will have to enter the appropriate phonetic 

symbols in the Pronunciation space manually. The available phonetic symbols and the 

corresponding pronunciation samples are shown in the chart on the right side of the 

window for convenient reference. You can enter a word with hyphens “-” between 

syllables so that the entered word can be automatically divided into notes when you 

actually use it in the piano roll. When the new word and pronunciation have been 

entered as required, click the [Add] button to actually register them in the dictionary. 

Registered words and their corresponding pronunciations are displayed in the list in 

the upper area of the User Word Registration window. 

 

 

Editing Existing Entries 

 

To edit an existing entry in the User Word Dictionary double-click the entry in the 

registered word list. The word and its corresponding phonetic symbols will 

automatically be entered in the Word and Pronunciation spaces near the bottom of the 

window where they can be edited as required. After editing click the [Add] button to 

register the changes. 

 

 

 



2-6. Adding Expression 
 

Basic expressive variations – attack, vibrato, and dynamics (including crescendo and 

diminuendo) – can be added to your sequence by dragging and dropping the 

appropriate icons from the VOCALOID Icon Palette (see 1-5. The Icon Palette  -> 

The Icon Palette). If it is not already showing, you will need to make the icon palette 

visible by clicking the “VOCALOID Icon Palette” item in the View menu (see 1-1. 

The Menus -> View). The length of objects that can be drag-stretched such as vibrato 

and crescendo or diminuendo, however, is affected by the Length setting (see 1-2. 

The Buttons & Indicators -> Length). Attack, vibrato, and dynamics objects can be 

deleted by single-clicking to highlight, and then pressing the [Delete] key on your 

computer keyboard. The only restriction is that expression objects cannot overlap 

within the same track. 

 

 

Vibrato 
 

Vibrato is added to individual notes in your sequence by dragging the icon 

corresponding to the desired type of vibrato onto the note to which it is to be applied. 

This version (Ver1.1) has a new function of adding vibrato automatically at the same 

time when a note is entered. This function is ON by default. Initially the vibrato will 

be applied to the latter half of the note, simulating the way a singer normally applies 

vibrato only to the last part of a note. If you select “Vibrato” from the Setting menu, 

the Vibrato Setting dialog in which you can change the vibrato setting will appear 

(see 1-1. The Menus -> Setting). 

You can adjust the length of the vibrato within the bounds of the note by moving the 

cursor over the end of the vibrato object so that the red double-headed stretch arrow 

appears ( ), and click-dragging the end of the vibrato object to resize it as required. 

If you move the cursor just inside the edge of the vibrato object the move symbol will 

appear ( ), allowing you to click-drag to reposition the vibrato object within the 

bounds of the note. If the cursor is placed over the center of the vibrato object the 

hand-pointer symbol will appear, allowing you to drag the vibrato object to another 
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note, or copy it to another note by clicking-and-dragging while holding the [Ctrl] key 

on your keyboard (a small [+] will appear next to the hand pointer while you do this). 

 

 

Vibrato Types 

 
Vibrato is such an important part of most vocalists’ expressive technique that many 

singers can be instantly recognized by their vibrato alone. Still, most singers will vary 

their vibrato some extent to match the mood of the music and the phrasing they 

choose. The vibrato icons give you a good range of choices to start with … then you 

can edit them to fine-tune the performance. 

 

 

Editing Vibrato Objects 
 

Double click any vibrato object that has been applied to the sequence to bring up its 

edit window. Edit the parameters as required and then click [OK] to make the changes 

and close the edit window, or [Cancel] to close the edit window without making any 

changes. 
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Variation… 

The [Variation…] button at the top of the edit window allows you to easily 

convert the current vibrato object to a different vibrato type. Click the 

[Variation…] button to bring up a list of the available types, click and 

highlight the type you want to convert the object to, then click the [OK] button 

(or simply double-click the type you want to convert to). 

 

Position 

The Position parameters allow you to numerically specify the position of the 

beginning of the vibrato object within the boundaries of the note to which it 

has been applied. From left to right the values are measure, beat, and clock. 

The maximum possible setting, dependent on the note length, is shown to the 

right of the position parameters. 

 

Duration 

Duration specifies the length (duration) of the vibrato object. This parameter is 

also limited by the length of the note to which the vibrato object has been 
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applied. From left to right the values are measure, beat, and clock. The 

maximum possible setting, dependent on the note length, is shown to the right 

of the duration parameters. 

 

Depth 

Open the graphic vibrato depth editing window by clicking the Depth 

[Setup…] button. 

 

 
 

The depth of vibrato produced by each vibrato object can be dynamically 

varied over its duration. The depth range is from 0 (minimum vibrato depth) to 

127 (maximum vibrato depth), with 64 being the normal default value. The 

vibrato objects initially have a static depth of 64, produced by the single 

control point at the left edge of the graphic depth edit window. You can add 

control points at any locations within the white area of the window 

corresponding to the duration of the vibrato object. Single points, freehand 

curves, or linear changes can easily be entered by using pencil tool available at 

the top of the window in conjunction with the DOT, FREE, and LINE input 

mode selectors (see 2-7. The Control Track -> Editing a Control Track). 

Control points can be erased with the eraser tool, and dragged to change their 

horizontal position or vertical value using the pointer tool. The value of 

selected control points can also be editing by using the increment and 
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decrement arrows in the Value indicator on the left side of the window, and 

the Interval parameter determines the spacing or “interval” of the control 

points (in clocks) generated by “free” or “line” input. 

Control point entry and editing is performed in the same way as in the 

VOCALOID control track (see 1-4. The Control Track  -> The Control Track). 

 

Rate 

Open the graphic vibrato rate editing window by clicking the Rate [Setup…] 

button. 

 

 
 

The rate (speed) of vibrato produced by each vibrato object can be 

dynamically varied over its duration. The rate range is from 0 (slowest 

vibrato) to 127 (fastest vibrato), with 64 being the normal default value. The 

vibrato objects initially have a static rate of 64, produced by the single control 

point at the left edge of the graphic rate edit window. You can add control 

points at any locations within the white area of the window corresponding to 

the duration of the vibrato object. Single points, freehand curves, or linear 

changes can easily be entered by using pencil tool available at the top of the 

window in conjunction with the DOT, FREE, and LINE input mode selectors 

(see 2-7. The Control Track -> Editing a Control Track). Control points can be 

erased with the eraser tool, and dragged to change their horizontal position or 
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vertical value using the pointer tool. The value of selected control points can 

also be editing by using the increment and decrement arrows in the Value 

indicator on the left side of the window, and the Interval parameter determines 

the spacing or “interval” of the control points (in clocks) generated by “free” 

or “line” input. 

Control point entry and editing is performed in the same was as in the 

VOCALOID control track (see 1-4. The Control Track -> The Control Track). 

 

Comment 

The comment space can be used to enter a text comment describing the object. 



Attack 
 

Like vibrato objects, attack objects are added to individual notes in your sequence by 

dragging the icon corresponding to the desired type of attack onto the note to which it 

is to be applied. Attack objects are always applied to the beginning of the target note, 

and cannot be stretched or moved within the note. Attack objects can be moved or 

copied to other notes in the same way as vibrato objects. 

 

 

Attack Types 

 
 

The attack is one of the most variable elements of vocal delivery, and a range of 

attack icons have been provided to simulate many of the most common variations. Of 

course, you can edit the attack parameters to create variations of your own. The type 

of attack produced by each icon is roughly indicated by its name … try them out to 

hear how they sound. 

 

 

Editing Attack Objects 

 

Double click any vibrato object that has been applied to the sequence to bring up its 

edit window. Edit the parameters as required and then click [OK] to make the changes 

and close the edit window, or [Cancel] to close the edit window without making any 

changes. 
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Variation… 

The [Variation…] button at the top of the edit window allows you to easily 

convert the current attack object to a different attack type. Click the 

[Variation…] button to bring up a list of the available types, click and 

highlight the type you want to convert the object to, then click the [OK] button 

(or simply double-click the type you want to convert to). 

 

Duration 

Duration specifies the length (duration) of the attack. The range is from 0 to 

127, with a default setting of 64. The attack time becomes shorter as this value 

is reduced toward 0, and longer as the value is increased toward 127. 

 

Depth 

This value sets the depth of the attack. Like the Duration parameter, above, 

Depth has a range of 0 to 127, with a default setting of 64. The attack depth 

becomes shallower as this value is reduced toward 0, and deeper as the value 

is increased toward 127. 
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Comment 

The comment space can be used to enter a text comment describing the object. 

 

 

Dynamics 
 

Dynamic objects can be placed at any point in the sequence window by dragging and 

dropping from the VOCALOID Icon Palette. Unlike vibrato and attack objects, 

dynamics do not have to be dropped on specific notes. The only restriction is that 

dynamics objects cannot overlap within the same track. You can drag the dynamics 

object to another position, or copy it to another location by clicking-and-dragging 

while holding the [Ctrl] key on your keyboard (a small [+] will appear next to the 

hand pointer while you do this). 

Note that these dynamics objects cause an immediate and abrupt change in dynamic 

level at the point at which they are placed, so they should normally be placed at the 

beginning of a note or series of notes to be affected (placing one of these dynamic 

objects in the middle of a note can cause unnatural level changes). The applied 

dynamic level will remain in effect until another dynamics or crescendo/diminuendo 

object is encountered during playback. For gradual dynamic changes use the 

Crescendo or Diminuendo objects described below. 

 

 

Dynamics Types 

 
 

The dynamics icons employ standard musical symbols to indicate dynamics, as listed 

in the chart below. 

 

ppp Pianississimo As soft as possible 

pp Pianissimo Very soft 

p Piano Soft 
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mp Mezzo Piano Moderately soft 

mf Mezzo Forte Moderately loud 

f Forte Loud 

ff Fortissimo Very loud 

fff Fortississimo As loud as possible 

 

 

Editing Dynamics Objects 

 

Double click any dynamics object that has been applied to the sequence to bring up its 

edit window. Edit the parameters as required and then click [OK] to make the changes 

and close the edit window, or [Cancel] to close the edit window without making any 

changes. 

 

 
 

Variation… 

The [Variation…] button at the top of the edit window allows you to easily 

convert the current dynamics object to a different dynamics type. Click the 

[Variation…] button to bring up a list of the available types, click and 
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highlight the type you want to convert the object to, then click the [OK] button 

(or simply double-click the type you want to convert to). 

 

Dynamics 

The level of each dynamics object can be adjusted via the Dynamics 

parameter over a small range limited by its type. The available ranges for the 

various dynamics types are shown in the drop-down menu to the right of the 

Dynamics parameter for reference. If the value you want is outside the range 

of the current dynamics type, use the [Variation…] button (above) to change 

the dynamics to the one with the range that encompasses the desired value. 

 

Comment 

The comment space can be used to enter a text comment describing the object. 

 

 

Crescendo & Diminuendo 
 

These dynamics objects can be used to produce gradual increases or decreases in 

loudness – i.e. crescendos or diminuendos. Like the dynamics objects described above, 

the crescendo and diminuendo objects can be placed at any point in the sequence 

window by dragging and dropping from the VOCALOID Icon Palette. Crescendo and 

diminuendo objects can span any number of notes, and do not have to be dropped on 

specific notes. The only restriction is that dynamics objects cannot overlap within the 

same track – this applies to both dynamics and crescendo/diminuendo objects. You 

can adjust the length of the crescendo or diminuendo by moving the cursor over the 

end of the object so that the red double-headed stretch arrow appears ( ), and 

click-dragging the end to resize it as required. If the cursor is placed over the center of 

the object the hand-pointer symbol will appear, allowing you to drag the crescendo or 

diminuendo object to another position, or copy it to another location by clicking-and-

dragging while holding the [Ctrl] key on your keyboard (a small [+] will appear next 

to the hand pointer while you do this). 
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Crescendo & Diminuendo Types 

 
 

The available crescendo and diminuendo types are fairly straightforward, as indicated 

by the symbols on the icons. You have a range of linear crescendos and diminuendos 

of varying intensities, and some swell-type crescendos and diminuendos (the symbols 

with the curved lines). 

 

 

Editing Crescendo & Diminuendo Objects 

 

Double click any crescendo or diminuendo object that has been applied to the 

sequence to bring up its edit window. 
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Variation… 

The [Variation…] button at the top of the edit window allows you to easily 

convert the current crescendo or diminuendo object to a different type. Click 

the [Variation…] button to bring up a list of the available types, click and 

highlight the type you want to convert the object to, then click the [OK] button 

(or simply double-click the type you want to convert to). 

 

Duration 

Duration specifies the length (duration) of the crescendo or diminuendo object. 

The maximum duration may be limited by the presence of other dynamics 

objects in the sequence (dynamics objects cannot overlap). From left to right 

the values are measure, beat, and clock. The maximum possible setting, 

dependent on the location of other dynamics objects, is shown to the right of 

the position parameters. 

 

Dynamics 

Open the graphic vibrato dynamics editing window by clicking the Dynamics 

[Setup…] button. 

 

 
 

The overall shape of the level change produced by each crescendo or 

diminuendo object can be dynamically varied over its duration. The level 
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range is from -127 (minimum level) to +127 (maximum level). You can add 

control points to the existing control line or curve at any locations within the 

white area of the window corresponding to the duration of the object. Single 

points, freehand curves, or linear changes can easily be entered by using 

pencil tool available at the top of the window in conjunction with the DOT, 

FREE, and LINE input mode selectors (see 2-7. The Control Track -> Editing 

a Control Track). Control points can be erased with the eraser tool, and 

dragged to change their horizontal position or vertical value using the pointer 

tool. The value of selected control points can also be editing by using the 

increment and decrement arrows in the Value indicator on the left side of the 

window, and the Interval parameter determines the spacing or “interval” of the 

control points (in clocks) generated by “free” or “line” input. 

Control point entry and editing is performed in the same was as in the 

VOCALOID control track (see 1-4. The Control Track -> The Control Track). 

 

Comment 

The comment space can be used to enter a text comment describing the object. 

 

 

Creating Custom Expression Icons 
 

Once you have edited an attack, vibrato, dynamics, crescendo, or diminuendo object, 

you can add the edited object to the VOCALOID Icon Palette for convenient access 

later by right-clicking the object in the sequence track and clicking “Add to Icon 

Palette” in the pop-up menu. This brings up the “Setup Icon name” window in which 

you can enter a name for your icon, and add a comment if you like. When you click 

[OK] the new icon will be added to the appropriate row in the VOCALOID Icon 

Palette with a “U” in the upper left corner to indicate that it is a “User” icon. Your 

custom icon can now be dragged to the sequence track and used in the same way as 

the default icons. 

 



 
 

To delete a custom icon, single-click the icon to highlight it, then press the [Delete] 

key on your computer keyboard. Click [OK] in the confirmation window, and the icon 

will be deleted. The default icons cannot be deleted. 
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2-7. The Control Track 
 

The VOCALOID control track can be used to create dynamic changes in a number of 

important parameters. You can, for example, use the control track to program subtle 

pitch bends like those that a live singer might use to add expression to his or her 

performance. You can also apply dynamic real-time variations to all of the singer’s 

voice parameters, producing shifts in sound a texture that can bring your vocal track 

to life. 

 

The control track is capable of displaying the control points for one control parameter 

at a time, as determined by the current selection to the left of the control track. The 

horizontal axis of the control track corresponds to time in the sequencer track above it, 

so a control change in the control track corresponds to the measure:beat:clock 

location and object immediately above it in the sequence track. The vertical axis of 

the control track corresponds to the value at that point for the currently selected 

control parameter. Higher control points produce higher values. The range for the 

currently selected parameter is displayed numerically immediately to the left of the 

control track. Lines connecting control points indicate how the control value will 

change over the interval between the points. 

 

 

Editing a Control Track 
 

Select a Control parameter To View or Edit 

Click the arrow and select a control parameter you want to view or edit. When the 

mouse pointer is located in the control track region, you can also switch the control 

parameters by pressing “PageUp” key or “PageDown” key. 



 
 

You can select only one control parameter to be displayed in the control track at a 

time, and the name of the currently selected parameter will appear in the control select 

bar. 
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Edit Existing Control Points 

Use the pointer tool to click and drag existing control points horizontally to change 

their measure:beat:clock location and/or vertically to change their value (note velocity 

control points can only be moved vertically – move the notes in the sequence track to 

change their positions). You can also click a control point with the pointer tool once 

to highlight it and then use the VALUE increment and decrement arrows to edit the 

point’s value, or numerically edit the value by double clicking the currently displayed 

value, entering a new value, and pressing [ENTER] on your keyboard. If you click 

and drag to select a group of control points, you can then click and drag one of the 

selected points to adjust the values of all points in the group. 

 

 
 

 

Create New Control Points 

With the sole exception of Note Velocity, you can create any number of new control 

points for any parameter using the pencil tool (note velocity control points can only 

be created by entering new notes in the sequencer track). You can enter control points 

singly using the DOT input mode, or in groups conforming to a specified curve or line 

using the FREE or LINE input mode. Points created in this way can be erased using 

the eraser tool (you can also simply highlight a point and hit the [Delete] key on your 

computer keyboard). And of course you can use the pointer tool to select and edit 

points as described above. 
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The Control Parameters 
 

Note Velocity 

Note velocity determines the individual loudness of each note in the sequence. 

Careful editing of note velocities can give your phrases a dynamic “flow” that can 

simulate the way a live singer might deliver a performance. Note velocity control 

points cannot be created using the pencil tool. They are created automatically 

whenever a note is entered in the sequence track, one per note. You can edit and 

select the note velocity control points using the pointer tool, and you can use the 

pencil tool in the FREE or LINE mode to draw a curve or line which the included 

points through notes will snap to when the mouse button is released. 

 

Singer Parameters 

All of the parameters described in the “Customizing the Singer’s Voice” section (see 

2-2. The Singer -> Customizing the Singer’s Voice) can be dynamically controlled via 

the control track. Select the desired parameter from the control select menu, use the 

pencil tool and an appropriate input mode to enter the control points, then edit as 

required. 

 

Pitch Bend 

The control range in the Pitch Bend control track is from –8192 to 8191. The central 

“0” value corresponds to no pitch change. With the maximum Pitch Bend Sensitivity 

setting (below) the overall pitch bend range allows pitch variation of ±2 octaves. Use 

the pencil tool and an appropriate input mode to enter the control points, then edit as 

required. 

 

Pitch Bend Sensitivity 

Determines to what degree pitch bend value changes (above) will affect the produced 

pitch. At the maximum setting of “24” (24 semitones) the full pitch bend value range 

will produce pitch variation of ±2 octaves. A setting of “12” allows full-range pitch 

bend of ±1 octave, and so on. This parameter makes it easy to use the full pitch scale 

to create even delicate pitch variations. 
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Singer 

When the Singer control parameter is selected the icon for the initial singer and any 

singer changes you have entered for the track will appear. No control points are used 

for the Singer track. You can change the singer at any point in the sequence, as many 

times as you like, by using the Pencil tool to enter a new singer in the control track: 

make sure “Singer” is selected from the Control Select menu, the click the Pencil tool 

at the point in the control track you want the change to occur. This will bring up the 

singer menu from which you can select the singer to be inserted (see 2-2. The Singer -

> Selecting a Singer). The new singer icon will appear in the control track when you 

click the [OK] button in the singer menu window. 

 

Portamento Timing 

Determines the timing of portamento between a note and the next one. The way of 

connecting between all notes normally depends on the Singing Style you select. Using 

this parameter, you can partly shift the timing before or after the default position in 

the selected Singing Style. The higher the value is, the later the timing shifts. The 

lower the value is, the earlier the timing shifts.   
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2-8. Using VOCALOID With Other Music Applications 
 

Exporting Wave Files 
 

To export your VOCALOID sequence as a WAV (audio) file that you can import into 

and play with other applications as required, select “Wave File …” from the 

File/Export menu. The “Export to Wave File” dialog window will appear allowing 

you to name and save the WAV file. Specify the location to which you want to save 

the file, enter the file name, and click [SAVE]. 

 

Wave file details can be specified in the  “AUDIO > Wave …” from the 

Setting menu (see 1-1. The Menus -> Setting). If your sequence has multiple 

tracks you can specify whether only the currently selected track is exported 

(“Current”), or all tracks are exported as a single WAV file (“Master”). In 

either case the level and pan settings in the VOCALOID Mixer window affect 

the levels and stereo position in the exported WAV file. There is also a 

"Mono" option which, when selected, causes mono file to be exported - the 

output level of each track will depend on the setting of the pan control in the 

mixer window (see 1-6. The Mixer Window  -> The Mixer Window).  

 

 

ReWire™ Synchronization 
 

VOCALOID can be synchronized with any sequencer or music application that is 

compatible with the ReWire™ protocol. In this version (Ver1.1), you can switch the 

play modes between “Play With Synthesis” and “Play After Synthesis” as when you 

use VOCALOID as a stand-alone application. Here’s the basic procedure for setting 

up ReWire™ synchronization: 

 

1. Always launch the host application first. 
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2. Launch the VOCALOID Editor once the host application is up and running. Make 

sure the tempo and time signature of the VOCALOID Editor and your host sequencer 

match. 

 

3. From the VOCALOID Setting menu select Audio > Device, and turn on the 

ReWire™ radio button in the Device window and click [OK]. If you select 

“ReWire(Master)”, all tracks are mixed down by VOCALOID mixer and sent to 

ReWire™ host. If you select “ReWire(All Tracks)”, each track is individually sent to 

ReWire™ host. 

It is also possible to assign individual tracks and the output of the master fader to your 

ReWire™ application via the VOCALOID Mixer window (see 1-6. The Mixer 

Window  -> The Mixer Window). 

 

When this has been done you should be able to select VOCALOID via the host’s 

device or ReWire™ menu (the actual nomenclature used will depend on the host 

application – refer to the host application owner’s manual for information on 

ReWire™ if necessary). You should be able to achieve accurate synchronization 

when operating the transport controls in either VOCALOID or the host application. 

 

Make sure the tempo of the VOCALOID Editor and your host sequencer match. If 

there are tempo changes somewhere in the sequence, it is convenient to use “Import 

ReWire Host Tempo” function to import the tempo setting from the host application 

to VOCALOID (see 1-1. The Menus -> Job -> Import ReWire Host Tempo). 

 

When you use ReWire™, press the [Synth/ReWire Prep.] button to send the MIDI 

information of “Play With Synthesis” tracks to ReWire host before pressing the [Play] 

button. 

If there are “Play After Synthesis” tracks, you should also press this button before 

pressing the [Play] button. Anyway, you should press [Synth/ReWire Prep.] button 

before pressing [Play] button in ReWire™ synchronization. 
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The VOCALOID VST instrument 
 

If you have a sequencing/audio application that is capable of using VST instruments, 

and you installed the VOCALOID VSTi plug-in during installation, you can 

conveniently use VOCALOID as a VST instrument. 

The basic procedure for using VOCALOID as a VST instrument is as follows: 

 

1. Save your VOCALOID sequence as a MIDI file (select “midi” file type in the 

VOCALOID Save dialog window). 

 

2. Import the VOCALOID MIDI file into your VSTi-compatible sequencer. 

 

A Note About VOCALOID MIDI Files: 

Midi files created by VOCALOID use special commands and do not include 

standard note-on/off events. VOCALOID MIDI files can therefore only be 

used to control VOCALOID. 

Also note that the control data for VOCALOID is being sent early to allow for 

processing and early vocal sounds, so there will appear to be a delay between 

the MIDI events in the MIDI track and the sounds produced. This is normal. 

 

3. Select the VOCALOID VST instrument from the appropriate menu or window in 

your VSTi-compatible application (refer to your application’s owner’s manual for 

further information if necessary). 

 

4. Make sure the output of the MIDI track is assigned to the VOCALOID VST 

instrument. 

 

VOCALOID should now function as a VST- instrument that can be combined with 

other sequenced and/or audio tracks for further production. 

 



 
 

The parameters available in the VOCALOID VST instrument are exactly the same as 

those available in the singer window (see 2-2. The Singer -> Selecting a Singer), but 

unlike the same parameters in the VOCALOID Editor the VST instrument parameters 

can be adjusted in real time. 

 

The version (Ver1.0 or Ver1.1) of the synthesis engine that VOCALOID VST 

instrument uses depends on the VOCALOID Editor setting. To switch the versions, 

select “AUDIO / Synthesis Engine” from the Setting menu. After changing the setting, 

click [OK] and restart VOCALOID VST instrument. 

 

Importing MIDI (SMF) Files 
 

You can import standard SMF (standard MIDI file) files you have created in another 

sequencer application and use the notes as the basis for VOCALOID tracks. Imported 

parameters include MIDI note on, note off, velocity, and pitch bend data. Since 

VOCALOID sequences can have up to 16 tracks, multitrack SMF files containing up 

to 16 tracks can be imported in one operation. 

 

SMF are imported via the standard File menu “Open …” dialog. When you open an 

SMF file, however, the SMP Options window will appear allowing you to choose 
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which tracks you want to import. Simply check or uncheck the tracks as required, 

then click [OK] to import the file.  

 
 

If the lyric meta-event is appropriately set in the standard MIDI file, the lyrics will be 

automatically imported. The lyrics are, however, not automatically transformed into 

phonemes. In this case, you should select “Phoneme Transformation” from the Lyrics 

menu and adjust the setting manually (see 2-5. Phoneme Functions -> Phoneme 

Transformation). 

 

2-9. Expanded selection 

When you select a certain region in the piano roll by dragging with the arrow pointer 

while holding the [Ctrl] key, the sequence events and the control parameters in the 

region (including the parameters that are not shown) will be also selected so that you 

can edit them. When the region is selected, it is highlighted. You can copy, cut, paste, 

and delete the sequence events as in the normal editing. This function is convenient to 

copy all items including part of control parameters in the selected regions at once.  

In order to move all sequence events and control parameters in the selected region at 

once, left-click one of the notes, and drag and drop it.   
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3. Appendix 
 

3-1. Phonetic Symbol Charts 
 

VOCALOID Phonetic Symbol Table (English) 
Symbol Sample Comments 
@ the sun (schwa) 
V strut   
e them   
I kit   
i: beef   
{ trap   
O: taught   
Q lot   
U put   
u: boot   
@r maker   
eI pay   
aI buy   
OI boy   
@U oat   
aU loud   
I@ beer   
e@ bear   
U@ poor   
O@ pour   
Q@ star   
w way   
j yellow   
b cab   
d bad   
g bag   
bh big beginning of syllable, with aspiration 
dh dog beginning of syllable, with aspiration 
gh god beginning of syllable, with aspiration 
dZ jeans   
v vote   
D their   
z resort   
Z Asia   

mailto:I@2
mailto:I@2
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m mind   
n night   
N long   
r red   
l feel   
l0 list beginning of syllable 
p dip   
t sit   
k rock   
ph peace beginning of syllable, with aspiration 
th top beginning of syllable, with aspiration 
kh kiss beginning of syllable, with aspiration 
tS touch   
f feel   
T think   
s sea   
S share   
h hat   
 

 

VOCALOID Phonetic Symbol Table (Japanese) 

Symbol Sample (in roman letters) Description 
a ai   
i  ima   
M uta   
e egao   
o omoi   
k kokoro   
k' kibou followed by /i/ 
g genki   
g' giri followed by /i/ 
N ongaku nasalized /g/ 
N' kagi followed by /i/, nasalized /g/ 
s sadame   
S shiawase   
z kizu   
Z iji   
dz zuboshi beginning of word 
dZ jibun beginning of word 
t taido   
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t' baraeti followed by /i/ 
ts tsuki   
tS inochi   
d daichi   
d' merodi followed by /i/ 
n namida   
J nioi followed by /i/ 
h hana   
h\ mahou inside a word 
C hinagiku followed by /i/ 
p\ hushigi   
p\' fianse   
b boku   
b' bijin followed by /i/ 
p posuto   
p' piano followed by /i/ 
m manako   
m' mirai followed by /i/ 
j yume   
4 sora   
4' rikutsu followed by /i/ 
w watashi   
N\ jikan   
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3-2. Shortcut Keys 

 

The menu shortcut keys are listed in the men us themselves, so please refer to the 

menus for those shortcuts. In cases in which the shortcut consists of a control-key + 

modifier key combination, the combination is listed to the right of the corresponding 

item in the menu. All other menu shortcuts comply with standard Windows 

procedure: if a character in a menu is underlined, hold the [ALT] key and press that 

character key to open the menu. You can then press the underlined character in the 

menu items to select the corresponding item. 

The remaining shortcut key operations are as follows: 

 
Transport Shortcuts 
 
Fast reverse Numeric keypad “-

“ (minus) key. 
Jump backward one measure. 

Fast Forward Numeric keypad 
“+“ (plus) key. 

Jump forward one measure. 

Play/Stop Space key or 
numeric keypad 
Enter key. 

Start playback if stopped, or stop 
playback if playing. 

Stop/Top Main keyboard 
period key or 
numeric keypad 
period key. 

Stops playback, or if playback is stopped 
jumps to the beginning of the sequence 
or the Start marker (if active). 

 
Edit Tool Shortcuts 
 
Pencil Ctrl＋W Switches to the pencil tool if the pointer 

tool is selected, or to the pointer tool if 
the pencil tool is selected. 

Eraser Ctrl＋E Switches to the eraser tool if the pointer 
tool is selected, or to the pointer tool if 
the eraser tool is selected. 

 
Switch Control Parameters 
 
“PageUp” Switch the control parameter one by one from bottom up 
“PageDown” Switch the control parameter one by one in descending order 
(These shortcuts are effective when the mouse pointer is in the control region) 
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3-3. Troubleshooting Q & A 
 

Note Editing Problems 
 

Q: I entered a number of notes but some or all are “grayed out” and won’t play. 

A: Some or all notes may be overlapping. You may need to adjust the positions of the 

notes by hand, or use the Normalize Notes command located in the Job menu (see 1-1. 

The Menus -> Job). 

 

Q: I imported an SMF file I made using another program, but some or all of the 

notes are “grayed out” and won’t play. 

A: Some or all notes may be overlapping. Each VOCALOID track is strictly 

monophonic and overlapping notes won’t play. Use the Normalize Notes command 

located in the Job menu (see 1-1. The Menus -> Job). 

 

Q: When I try to enter notes a strange “prohibited” mark appears beside the 

cursor and I can’t enter any notes. 

A: You are probably trying to enter notes in the pre-measure area (the negative-

numbered measures before measure “1”). You can only enter notes from measure 1 

onwards. 

 

Q: The notes don’t appear to be overlapping and yet they are grayed out. 

A: The displayed and actual positions of the notes may vary slightly depending on the 

Grid and Length settings. Either change the Grid and Length settings, or use the 

Normalize Notes command located in the Job menu (see 1-1. The Menus -> Job). 

 

Q: I get no sound when I enter short notes. 

A: The same would happen with a human singer. VOCALOID needs notes that are 

long enough for it to sing. 

 

Q: I shortened some rests between notes and ended up with a continuous note. 

A: Once again, the same would happen with a human singer. VOCALOID needs time 
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to respond. 

 

 

Lyric Editing Problems 
 

Q: When I use an English library, only an “ooh” sound plays back even though 

I’ve properly entered some lyrics. 

A: Check your spelling carefully first. If you’ve done it and still can’t get the 

phoneme transformation to work properly, try entering the phonetic symbols yourself.  

Check that the correct phonetic symbols appear below the notes (see 2-5. Phoneme 

Functions). 

 

Q: I entered the phonetic symbols myself, but now I get no sound at all. 

A: The phonetic symbols within each note must be separated by spaces. Also, only 

one syllable can be entered for each note. If a note has no syllable, or more than one 

syllable, it will produce no sound. 

 

Q: I entered phonetic symbols myself, and then changed the lyric text, and now 

the phoneme is not changed.  

A: The phonetic symbols you entered are protected. You will need to go to the 

Phoneme Editor and uncheck the appropriate “PROTECT” checkbox(es) (see 2-5. 

Phoneme Functions). 

 

 

Expression Problems 
 

Q: I can’t place the dynamics icons (ff, crescendos, etc.) into the sequence track. 

A: You may have set the dynamics mode to “Expert.” Change it back to “Standard” if 

you want to use the icons (see 1-1. The Menus -> Job). 

 

 



Synthesis Problems 
 

Q: I get no sound at all! 

A: Check everything from your selected audio device to your physical audio 

connections. If you have more than one audio device installed in your computer, the 

software may be assigned to the wrong device. Check your AUDIO > Device … 

settings in the Settings menu. 

 

Q: After entering some lyrics, I changed the singer and now I get no sound. 

A: You may have switched to a singer of a different language. Phonetic symbols that 

do not apply to the language of the currently selected singer will be ignored, and as a 

result you will get no sound. 

 

Q: The playback sound is intermittent. 

A: If the play mode is set to “Play With Synthesis,” playback may be intermittent on 

some computers that possess lower speed. In such cases, left-click the round button of 

the track selector tab and select “Play After Synthesis” mode. (see 1-3. The Sequence 

Window -> Sequence Track -> Track Selector Tabs) 

 Please also try the followings: 

 Increase "Pre-Send Time" in a dialog displayed by selecting “Setting> 

VOCALOID MIDI > Option” from the menu. 
 

 
 

 Increase "Buffer Size" in a dialog displayed by selecting “Audio > Device” from 

the menu. 
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 Increase the buffer size or latency of the sound device (if possible). 

 Set the sampling rate to 44.1kHz. 

 Reduce the number of “Play With Synthesis” tracks. 

  

Q: Playback of the VOCALOID VST instrument is intermittent. 

A: This can happen on some computers that possess lower speed, or if the CPU load 

is particularly high. Try reducing the number of VOCALOID tracks and/or quitting 

other software synthesizers. Mid-track singer changes can also increase the CPU load 

enough to cause this problem. It is safer not to change singers during a track. Please 

also try the followings: 

 In creating the sequence on the VOCALOID Editor, increase "Pre-Send Time" in 

a dialog displayed by selecting “Setting >VOCALOID MIDI > Option” from the 

menu. 

 Increase the buffer size or latency in the sound device setting of the host 

sequencer. Consider using MME driver (which normally has larger buffer size) 

rather than ASIO. 

 Set the sampling rate to 44.1kHz. 
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Q: Sometimes the VOCALOID VST instrument produces no sound. 

A: This problem can occur if you are simultaneously sending a large number of MIDI 

messages to the host sequencer. Try reducing the density of the control change 

messages being sent, for example. 

 

Q: The locations of the MIDI data being sent to the VST instrument and the 

timing of the sounds produced are different. 

A: VOCALOID uses special MIDI message to represent the notes and singer data, 

and these are sent ahead of the actual sound timing. 

 

Q: I tried using a MIDI file produced by the VOCALOID Editor with another 

tone generator, but was not able to produce any sound. 

A: VOCALOID uses special MIDI messages that are different from the standard note 

on and off messages used by normal tone generators. VOCALOID MIDI data cannot 

be used to drive conventional tone generators. 

 

Q: When I use ReWire™, will the two applications are synchronized properly 

even if the VOCALOID Editor’s tempo and/or time signature is different from 

that of my host sequencer? 

A: Tempo setting of the host application can be imported by using “Import ReWire 

Host Tempo” function (see 1-1. The Menus -> Job -> Import ReWire Host Tempo).  

Time signature differences can not be automatically adjusted. Make sure the tempo 

and time signature of the VOCALOID Editor and your host sequencer match. 

 

Q. While I use VOCALOID with Cubase, the Sampling Rate is changed to 

32kHz after the computer beeps. 

A. In this case, turn off the OS sound setting to avoid it. For example, for Windows 

XP, select “Sound and Audio Device” from Control Panel and select “No Sound” in 

the Sound Setting dialog in the Sound tab.  
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